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წინამდებარე სახელმძღვანელოს მიზანია დაეხმაროს სტუდენტს ინფორმატიკის 

და კომპიუტერული ტექნოლოგიების ელემენტების დაუფლებაში, გააცნოს მას 

ინტერნეტის მუშაობის პრინციპები, ინტერნეტში საჭირო მასალის მოძიების მეთოდები 

და ელექტრონული ფოსტის შესაძლებლობები. სახელმძღვანელოს მიზანია სტუდენტს 

მისცეს ცოდნა საოფისე პროგრამებში მუშაობისა, რათა შეძლოს მათი ეფექტურად 

გამოყენება პროფესიული საქმიანობისას. 

სახელმძღვანელოში განხილულია შემდეგი თემები: კომპიუტერების 

კლასიფიკაცია და არქიტექტურა, ოპერაციული სისტემა Windows 10, ინტერნეტი და 

ვირუსებთან ბრძოლა, საოფისე პროგრამები MS Word 2016, MS PowerPoint 2016 და MS 

Excel 2016. აგრეთვე MS Access 2016-ის მაგალითზე განხილულია მონაცემთა ბაზებთან 

მუშაობის ძირითადი პრინციპები. 

სახელმძღვანელო შედგენილია საქართველოს ფიზიკური აღზრდისა და სპორტის 

სახელმწიფო სასწავლო უნივერსიტეტის სტუდენტებისათვის სასწავლო პროგრამის 

მიხედვით. 

 

შემდგენელი: 

ეგოიანი ა. - ფიზიკა-მათემატიკის დოქტორი, საქართველოს ფიზიკური აღზრდისა 

და სპორტის სახელმწიფო სასწავლო უნივერსიტეტის ბიომექანიკისა და კომპიუტერული 

ტექნოლოგიების კათედრის ასოცირებული პროფესორი. 

 

 

 

 

 

 

 

რეცენზენტი: 

მოისწრაფიშვილი კ. - ფიზიკა-მათემატიკის დოქტორი, პროფესორი, 

საქართველოს ფიზიკური აღზრდისა და სპორტის სახელმწიფო სასწავლო 

უნივერსიტეტის ბიომექანიკისა და კომპიუტერული ტექნოლოგიების კათედრის გამგე. 
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თემა 1. საწყისი ცნობები კომპიუტერის შესახებ 

კომპიუტერი (ინგლ. computer) - მოწყობილობა, რომლის დაპროგრამების 

მეშვეობით ხდება არითმეტიკული ან ლოგიკური ოპერაციის ავტომატური შესრულება. 

ვინაიდან ოპერაციების თანმიმდევრობა შეიძლება შეიცვალოს, კომპიუტერს შეუძლია 

ერთდროულად რამდენიმე მათგანის შესრულება. 

თანამედროვე კომპიუტერები, რომლებიც ეფუძნება ინტეგრირებულ წრედებს, 

მილიონიდან მილიარდამდე უფრო მეტად უნარიანია, ვიდრე ადრეული მანქანები და 

იკავებენ მცირე სივრცეს. მარტივი კომპიუტერები თავსდება მობილურ 

მოწყობილობებში. მობილური კომპიუტერები იკვებება მცირე ზომის ბატარეებით. 

კომპიუტერები, დანიშნულებისა და ტექნიკური მახასიათებლების მიხედვით, 

იყოფა: სუპერკომპიუტერებად, მეინფრეიმებად, სერვერებად და პერსონალურ 

კომპიუტერებად.  

კომპიუტერი შედგება შემდეგი ძირითადი მოწყობილობებისაგან: სისტემური 

პლატა (Motherboard), რომელიც წარმოადგენს კომპიუტერის ცენტრალურ ნაწილს, მისი 

ძირითადი დანიშნულებაა ინფორმაციის დამუშავების აპარატული ორგანიზაცია; 

მონიტორი ანუ დისპლეი, რომლის დანიშნულებაა ტექსტური და გრაფიკული 

ინფორმაციის გამოსახვა ვიზუალური აღქმისათვის; დამგროვებელი მყარ მაგნიტურ 

დისკოზე (ვინჩესტერი); კლავიატურა, რომლის დანიშნულებაა კომპიუტერში 

ინფორმაციისა და პროგრამების შეტანა; პრინტერი, (საბეჭდი მოწყობილობა), ნაბეჭდი 

სახით ინფორმაციის გამოსატანად. გარდა ამისა, კომპიუტერს შეიძლება მიუერთდეს სხვა 

სახის მოწყობილობანი, მაგალითად, “მაუსი”, რომელიც აიოლებს მონაცემთა შეტანის 

პროცესს, სკანერი გრაფიკული ინფორმაციის შეტანისათვის, პლოტერი გრაფიკული 

ინფორმაციის გამოტანისათვის და სხვა. 

სისტემური პლატის მთავარი კვანძებია:  

1.) ძირითადი მიკროპროცესორი (CPU), რომელიც მართავს კომპიუტერის 

მუშაობას და ასრულებს არითმეტიკულ და ლოგიკურ ოპერაციებს;  

2.) ოპერატიული (შიდა) მეხსიერება (RAM), რომელშიც ინახება კონკრეტულ 

მომენტში საჭირო პროგრამები და მონაცემები;  

3.) ელექტრონული სქემები (კონტროლერები), რომლებიც უზრუნველყოფენ 

კომპიუტერის სხვადასხვა გარე მოწყობილობების (ეკრანის, დისკური მოწყობილობების, 

პრინტერის, კლავიატურის) მართვას;  

4.) შეტანა-გამოტანის პორტები, რომელთა საშუალებით ხდება ინფორმაციის 

გაცვლა პროცესორსა და გარე მოწყობილობებს შორის. 

დისკური მოწყობილობების ტევადობა მეხსიერება (ინფორმაციის რაოდენობა) 

იზომება ბაიტებით. მიახლოებით შეიძლება ითქვას, რომ ერთი ბაიტი - ეს იმხელაა 

მეხსიერებაა, რომელიც საჭიროა ერთი სიმბოლოს (ასო, ციფრი, და ა.შ.) 

დასამახსოვრებლად - ბაიტში 8 ბიტია. რეალურად გამოიყენება უფრო დიდი 

ერთეულები, მაგალითად კილობაიტი (1024 ბაიტი), მეგაბაიტი (106 ბაიტი) და გიგაბაიტი 

(109 ბაიტი). 

კომპიუტერები თვლის ორობით სისტემას იყენებენ იმიტომ, რომ მას მთელი რიგი 

უპირატესობა აქვს სხვა სისტემების მიმართ: 
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• მისი რეალიზაციისათვის საჭირო ტექნიკური მოწყობილობები ხასიათდებიან 

ორი მდგრადი მდგომარეობით (არის დენი - არ არის დენი, დამაგნიტებულია - 

არაა დამაგნიტებული და ა.შ.); 

• ინფორმაციის წარმოდგენა მხოლოდ ორი მდგომარეობის საშუალებით უფრო 

საიმედოა; 

• შესაძლებელია ბულის ალგებრის აპარატის გამოყენება ინფორმაციის 

ლოგიკური გარდაქმნის შესასრულებლად, ვინაიდან ბულის ალგებრაში 

ლოგიკურ ცვლადს შეიძლება ჰქონდეს მხოლოდ ორი მნიშვნელობა: 

„ჭეშმარიტი“ (“TRUE” - „დიახ“) და „მცდარი“ (“FALSE” - „არა“). ეს ორივე 

სიტყვიერი აღნიშვნა შეგვიძლია შევცვალით „1“-ით და „0“-ით. ბულის ლოგიკის 

ძირითადი ოპერაციებია: უარყოფა, დიზიუნქცია, კონიუნქცია, იმპლიკაცია და 

ეკვივალენცია. 

ინფორმატიკა - მეცნიერება ინფორმაციის მიღების, დამუშავების, შენახვის და 

გაცემის შესახებ. ინფორმატიკა არის მჭიდრო კავშირში კომპიუტერთან, ნებისმიერი 

კომპიუტერი იმართება პროგრამებით, რომლებიც თავის მხრივ მუშაობენ სხვადასხვა 

ალგორითმით. შესაბამისად ალგორითმიკა შეიძლება ჩაითვალოს ინფორმატიკის 

ბირთვად. 

დონალდ კნუტმა 1968 წ. შემოიტანა ალგორითმის შემდეგი განმარტება: 

ალგორითმი არის ამოცანის ამოხსნისთვის საჭირო ოპერაციების თანმიმდევრობის 

განმსაზღვრელი წესები. 

 

პრაქტიკული სამუშაოები: ინფორმაციის საზომი ერთეულების ერთმანეთში 

გადაყვანა; რიცხვების თვლის ათობითი სისტემიდან გადაყვანა ორობითში და პირიქით; 

ლოგიკური გამონათქვამის ჭეშმარიტობის დადგენა; ალგორითმის ბლოკ-სქემის აგება. 
 

თემა 2. ოპერაციული სისტემა Windows 10 

ოპერაციული სისტემა Windows 10 - ეს არის მაიკროსოფტის 1985 წელს 20 ნოემბერს 

შექმნილი ოპერაციული სისტემის თანამედროვე ვერსია. ამ სისტემით დღესდღეობით 

აღჭურვილია მსოფლიოში არსებული კომპიუტერების არანაკლებ 80%. იგი წარმოადგენს  

Mac OS-ის, Android-ის და  Linux-ის კონკურენტს. 

ამ სისტემის ძირითადი მახასიათებლებია: 

1. უნივერსალურობა - ეს სისტემა შეიძლება დავაყენოთ და თანაბარი წარმატებით 

გამოვიყენოთ პერსონალურ კომპიუტერებზე, ლეპტოპებზე, პლანშეტებზე, მობილურ 

ტელეფონებზე; 

2. გადატანითობა - შეიძლება ერთი მოწყობილობა მივაბათ რამდენიმე 

სააღრიცხვო ექაუნტს, რაც საშუალებას მოგვცემს ყველა მათგანში გამოვიყენოთ ერთიანი 

მისამართების წიგნი, ელ. ფოსტა, პროგრამების პარამეტრები; 

3. ღრუბლოვანი სერვისების მხარდაჭერა - შეგვიძლია ჩვენი კომპიუტერის 

ნაცვლად შევინახოთ ჩვენი სურათები, დოკუმენტები, მუსიკა ღრუბლოვან სერვისებში, 

მაგალითად, One Drive-ში და გამოვიყენოთ ისინი ჩვენ ნებისმიერ Windows ოპერაციული 

სისტემის მხარდაჭერის მქონე მოწყობილობაზე; 

4. და ასევე Windows 10 წარმოადგენს წინა ოპერაციულ სისტემებთან შედარებით 

უფრო დახვეწილ, სწრაფ და მოქნილ სისტემას. 
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სასტარტო მენიუ იხსნება Start ღილაკზე ერთჯერადი დაწკაპუნებით: მარცხენა 

მხარეს ნაჩვენებია ყველა ის პროგრამა, რომელიც კომპიუტერში დაინსტალირებულია - 

ისინი დალაგებულია ანბანის მიხედვით. ხოლო ამ ჩამონათვალის თავში - კერძოდ 

პუნქტში Most Used („ხშირად გამოყენებულები“) მოცემულია ის პროგრამები, რომლებსაც 

უფრო ხშირად ვიყენებთ. პროგრამის გასაშვებად საჭიროა ერთხელ დავაწკაპუნოთ მასზე. 

იმ შემთხვევაში, თუ პროგრამის გამშვები მოთავსებულია საქაღალდეში, ჯერ იხსნება იგი, 

მერე უნდა მოვძებნოთ საჭირო პროგრამა და გავუშვათ.  

ყველაზე დაბლა მდებარე ღილაკი Power გამოიყენება კომპიუტერის 

გამოსართავად ან გადასატვირთად. კერძოდ, მასზე დაწკაპუნებით გამოსულ მენიუში 

პირველი პუნქტი - Shut down - კომპიუტერს გამორთავს, ხოლო პუნქტი Restart - 

გადართავს. 

ღილაკი Settings („პარამეტრები“) გამოიტანს ფანჯარას კომპიუტერის მართვის 

პარამეტრებით, რომელსაც განვიხილავთ შემდგომში. 

File Explorer წარმოადგენს ჩვენთვის ასევე გასული საუკუნის ოთხმოცდაათიანი 

წლებიდან კარგად ნაცნობ ძირითად ფანჯარას „ფაილების მიმომხილველს“, რომელშიც 

მოცემულია ჩვენს კომპიუტერში შენახული ყველა ფაილი და საქაღალდე. აქვე შეგვიძლია 

ვიხილოთ ინფორმაციის დამამახსოვრებელი მოწყობილობები. ეს ღილაკი ასევე 

დუბლირებულია ამოცანათა პანელზეც. 

შემდეგი ღილაკი (“CompUser”) გამოიყენება ჩვენს მიერ შექმნილი მომხმარებლის 

მონაცემების და კომპანია Microsoft-ში ჩვენი სააღრიცხვო ექაუნტის მონაცემების 

სამართავად. 

ხშირად გამოყენებული პროგრამები მათი მოძებნის გამარტივების მიზნით 

შეგვიძლია განვათავსოთ მენიუს მარჯვენა მხარეს. ამისათვის საჭიროა პროგრამების 

ჩამონათვალში ან სამუშაო მაგიდაზე მოვძებნოთ პროგრამის გამშვები პიქტოგრამა, 

დავაწკაპუნოთ მასზე მაუსის მარჯვენა ღილაკით და გამოსულ კონტექსტურ მენიუში 

ავირჩიოთ პუნქტი Pin to Start („სტარტში დამატება“) - პიქტოგრამა უკვე დამატებულია. 

დამატებული პიქტოგრამის წასაშლელად დავდგეთ მასზე მაუსით და მაუსის 

მარჯვენა ღილაკზე დაწკაპუნებით გამოსულ ფანჯარაში ავირჩიოთ ბრძანება Unpin from 

Start („სტარტიდან მოხსნა“). 

ამოცანათა პანელი Task Bar წარმოადგენს ჰორიზონტალურ ზოლს ეკრანის ქვედა 

ნაწილში. ამოცანათა პანელის მარცხენა კუთხეში განთავსებულია სასტარტო მენიუს 

ღილაკი, რომელზეც პერიოდულად ჩნდება გახსნილი საქაღალდეების პიქტოგრამები. 

პროგრამის პიქტოგრამის ამოცანათა ზოლზე მისამაგრაბლად ვიპოვოთ ეს 

პროგრამა სასტარტო მენიუში ან სამუშაო მაგიდაზე და ამ პროგრამის კონტექსტური 

მენიუდან ავირჩიოთ ბრძანება Pin to Task Bar. 

პროგრამის პიქტოგრამის სასტარტო ამოცანათა ზოლიდან ამოსაღებად ამ 

პროგრამის კონტექსტური მენიუდან შევასრულოთ შესაბამისად ბრძანებები Unpin from 

Task Bar. 

ფანჯრის შიგთავსი. ოპერაციული სისტემა Windows 10, როგორც მისი 

წინამორბედი მაიკროსოფტის Windows-ის ოპერაციული სისტემები, მომხმარებელთან 

ურთიერთობს ფანჯრების საშუალებით. იგი წარმოადგენს ოპერაციული სისტემის 

მთავარ კომპონენტს. იმდენად მთავარს, რომ მისი სახელი დაერქვა ოპერაციულ 

სისტემას. ნებისმიერი საქაღალდე, ნებისმიერი პროგრამა იხსნება ფანჯრის ფორმით. 

შეგვიძლია გავხსნათ იმდენი ფანჯარა, რამდენიც გვსურს, გავხსნათ საქაღალდე მაუსის 
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მარცხენა  ღილაკზე ორჯერ დაწკაპუნებით. ფანჯრებთან მუშაობის წესი სტანდარტულია: 

ანუ, ისეთივეა, როგორც წინა ოპერაციულ სისტემებში. მაგალითად, ფანჯრის გადიდება, 

დაპატარავება, ჩაკეცვა, დახურვა, გადაადგილება, მაუსით ჩარჩოზე მოკიდებით 

დაპატარავება ან გაზრდა. თუმცა, ახალ ოპერაციულ სისტემას დამატებული აქვს ახალი 

ფუნქციები და შესაძლებლობები, რომლებსაც ეხლავე განვიხილავთ. 

მაგალითად, ფანჯრის ზემოთ მარცხენა კუთხეში გამოტანილია MS Word-ის 

მსგავსი სწრაფი წვდომის პანელი, საიდანაც შეგვიძლია ფანჯარაში მონიშნული 

ნებისმიერი ობიექტის თვისებების ნახვა. იმ შემთხვევაში, თუ ობიექტი მონიშნული არ 

არის, გამოდის კომპიუტერის პარამეტრები. შეგვიძლია შევქმნათ საქაღალდე და ამ 

სტანდარტული ორი ფუნქციის გარდა შეგვიძლია დავამატოთ ჩვენთვის სასურველი 

ღილაკები: ბოლოს შესრულებული ოპერაციის გაუქმება, აღდგენა, მონიშნული ობიექტის 

წაშლა, ობიექტისათვის სახელის გადარქმევა, შეგვიძლია სწრაფი წვდომის პანელი 

ჩამოვიტანოთ ლენტის ქვემოთ ან, პირიქით, დავაბრუნოთ ძველ ადგილას, და, ბოლოს, 

დავფაროთ ლენტი ან, პირიქით, გამოვაჩინოთ იგი. 

სწრაფი წვდომის პანელის ქვემოთ მოცემულია ოთხი ჩანართი, რომლებშიც 

შესასრულებელი ბრძანებების ღილაკები დაჯგუფებულია გარკვეული კატეგორიების 

მიხედვით. ჩანართი File გვიჩვენებს ყველა იმ საქაღალდეს, რომლებიც გამოყენებულია 

ბოლოს და გვაძლევს მათზე სწრაფი გადასვლის საშუალებას. Open New Window 

გამოიყენება ახალი ფანჯრის გასახსნელად, რომელიც შეიძლება, მაგალითად, 

დაგვჭირდეს სხვა საქაღალდის გახსნისათვის. პროგრამული კონსოლი Open command 

prompt გათვალისწინებულია ოპერაციული სისტემის ბრძანებების შესატანად და 

შესასრულებლად. Folder Options - საქაღალდისა და ძებნის პარამეტრების შეცვლა, Help - 

დახმარება და Close - ფანჯრის დახურვა. 

ჩანართში Home მოცემულია ძირითადად გამოყენებული ღილაკები - მაგალითად, 

ღილაკები ფაილის ან საქაღალდის კოპირებისა ან ჩასმისათვის, წაშლა, სახელის 

გადარქმევა, საქაღალდის შექმნა, თვისებები და ფანჯარაში არსებული ობიექტების 

მონიშვნის ფუნქციები - მაგალითად, ყველა მათგანის მონიშვნა, ან უბრალოდ მონიშვნის 

გაუქმება. 

ჩანართი Share გვაძლევს ობიექტების ღრუბლოვან სერვისებში გაზიარების ან ელ. 

ფოსტით გაგზავნის საშუალებას. შეგვიძლია დავაარქივოთ ობიექტი, შეგვიძლია 

ჩავწეროთ ობიქტი დისკზე ან დავბეჭდოთ პრინტერზე. 

ჩანართი View გვაძლევს საშუალებას დავფაროთ ან გამოვიტანოთ ნავიგაციის 

პანელი, გამოვიტანოთ ან დავფაროთ შიგთავსის დათვალიერების პანელი მარჯვენა 

მხარეს, ჩვენი შეხედულებისამებრ შევცვალოთ ობიექტების ხედი, დავალაგოთ ისინი 

გარკვეული პარამეტრების მიხედვით - მაგალითად, სახელის, ზომის, ტიპის ან შექმნის 

თარიღის მიხედვით, გამოვაჩინოთ ან დავფაროთ ფარული საქაღალდეები და ფაილები.  

მისამართის ველში ჩვენ შეგვიძლია ვიხილოთ მონიშნული ობიექტის მისამართი 

და ასევე ძებნის ველი, რომელიც საშუალებას გვაძლევს მოვძებნოთ კონკრეტული ფაილი 

ან საქაღალდე დასახელების ან დასახელების ნაწილის მიხედვით. 

სამუშაო მაგიდა (Desktop). ის ძირითადად იგივეა, რაც წინა ოპერაციულ 

სისტემემში. შესაძლებელია მასზე საქაღალდეების, ფაილების განლაგება, 

პიქტოგრამების შექმნა, გადაადგილება და სხვა.  
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კონტექსტური მენიუს საშუალებით შეგვიძლია: შევცვალოთ პიქტოგრამების ზომა 

(View→Large (Medium, Small) icons), გამოვაჩინოთ ან დავმალოთ მაგიდაზე არსებული 

ობიექტები (View→Show desktop icons), გადავტვირთოთ მხოლოდ სამუშაო მაგიდა 

(Refresh), განვახორციელოთ ბუფერიდან ჩასმის (Paste) და ბოლოს შესრულებული 

ოპერაციის გაუქმება (Undo), შევქმნათ ახალი საქაღალდე ან სასურველი ტიპის ფაილი 

(New). აქედანვე შესაძლებელია სამუშაო მაგიდის პერსონალიზაცია და დისპლეის 

პარამეტრების მართვა (Personalize). ბრძანებების Personalize→Themes→Desktop icon 

settings შესრულების შემდეგ გამოიძახება დიალოგური ფანჯარა Desktop Icon Settings, 

საიდანაც შეგვიძლია დავამატოთ სამუშაო მაგიდაზე ისეთი პიქტოგრამები როგორიცაა 

„ჩემი კომპიუტერი“ (This PC) და „მომხმარებლის საქაღალდე“ (User’s files). 

Windows 10 გვაძლევს საშუალებას შევქმნათ რამდენიმე ვირტუალური სამუშაო 

მაგიდა და გავანაწილოთ გაშვებული პროგრამები მათზე (Task View→New desktop), რათა 

მოხერხებული გავხადოთ მათი გამოყენება. 

მენიუ პარამეტრები (Settings). ოპერაციული სისტემის განხილვის შემდეგ 

საინტერესო იქნება ვისწავლოთ როგორ განვმარტოთ მისი მუშაობა და მაქსიმალურად 

მოვარგოთ ჩვენ საჭიროებებს. სისტემის მართვის პარამეტრების ნახვის რამდენიმე 

ვარიანტი არსებობს: სასტარტო მენიუდან Settings ღილაკზე დაწკაპუნებით, Start 

ღილაკის კონტექსტური მენიუდან   ბრძანებით Control Panel (ძველი ვარიანტი) და 

შეტყობინებების ცენტრიდან All settings ღილაკზე დაწკაპუნებით. ვისარგებლოთ 

პირველი ვარიანტით: გაიხსნება დიალოგური ფანჯარა Settings, რომელშიც ოპერაციული 

სისტემის პარამეტრები დაჯგუფებულია კატეგორიების მიხედვით: 

System - აქ მოცემულია სისტემური პარამეტრები: ეკრანის, შეტყობინებების, 

პროგრამების, ელექტროენერგიით კვების პარამეტრები; 

Devices - მოწყობილობების (პრინტერები, მაუსი, კლავიატურა და სხვა) მართვის 

პარამეტრები; 

Network & Internet - ქსელი და ინტერნეტი, ინტერნეტის, უკაბელო ინტერნეტის, 

თვითმფრინავის რეჟიმის, ვირტუალური ქსელების პარამეტრები; 

Personalization - პერსონალიზაცია: ფონის გამოსახულება, საწყისი ეკრანი, ფერები; 

Accounts - მომხმარებლების სააღრიცხვო პარამეტრების მართვა; 

Time & language - პარამეტრები, რომლებიც მართავენ დროს და ენებს; 

Ease of Access - შეზღუდული შესაძლებლობის მქონე პირებისთვის განკუთვნილი 

ოპციები; 

Privacy - პირადულობა; 

Update & Security - დაცვა და განახლება. 
 

პრაქტიკული სამუშაოები: ფაილებზე და საქაღალდეებზე სხვადასხვა 

ოპერაციების შესრულება (შექმნა, კოპირება, წაშლა, სახელის შეცვლა და დალაგება 

ფანჯარაში გარკვეული ნიშნის მიხედვით); დისპლეის პარამეტრების შეცვლა; ახალი 

მომხმარებლის დამატება კომპიუტერში. 
 

თემა 3. ინტერნეტი. ვირუსები და მათთან ბრძოლა 

ინტერნეტი. ინტერნეტი (Internet) არის "მსოფლიო-ქსელი", ერთმანეთზე 

მიერთებული კომპიუტერების საჯაროდ ხელმისაწვდომი ქსელი. ინტერნეტს ზოგჯერ 

ეძახიან უბრალოდ "ქსელს"(The Net), ანუ ქსელთა ქსელს, სადაც მომხმარებლებს, თუ მათ 
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აქვთ უფლებები, შეუძლიათ ნებისმიერი კომპიუტერიდან მიიღონ ინფორმაცია. 

ინტერნეტი აღნიშნავს გლობალურ კომპიუტერულ ქსელს, რომელიც ეფუძნება IP 

პროტოკოლს და პაკეტთა მარშრუტიზაციას. ინტერნეტი ქმნის გლობალურ 

საინფორმაციო სივრცეს და წარმოადგენს მსოფლიო ქსელის საფუძველს. 

IP (Internet Protocol - ქსელთაშორისი ოქმი) მარშრუტიზაციის ქსელური ოქმი, 

TCP/IP ოქმების სტეკის საფუძველი. 

IP ოქმი (RFC 791) გამოიყენება ქსელის ერთი ჰოსტიდან მეორეზე მონაცემთა 

არასანდო (პაკეტებად დაყოფილად) გადასაცემად. ეს ნიშნავს, რომ ამ ოქმის დონეზე 

მონაცემთა დანიშნულებამდე უცვლელად მისვლის გარანტია არ არსებობს. პაკეტები 

შეიძლება თავდაპირველი თანმიმდევრობით არ მივიდნენ, დაზიანდნენ ან საერთოდ 

დაიკარგონ. საიმედოობის გარანტიას იძლევა ისეთი სატრანსპორტო ოქმი, როგორიცაა 

TCP (Transmission Control Protocol), რომელიც IP-ს ტრანსპორტად იყენებს. 

ინტერნეტში გამოიყენება მეოთხე ვერსიის IP, რომელიც ასევე ცნობილია როგორც 

IPv4. ამ ვერსიის IP ოქმში, ქსელში არსებულ ყოველ წერტილს მიენიჭება IP მისამართი, 

რომელიც ოთხი ოქტეტისგან შედგება (მაგ. 192.68.20.15). ამგვარად ქვექსელებში 

კომპიუტერები ერთიანდებიან მისამართის საერთო პირველი ბიტებით. ამ პირველ 

ბიტებს ასევე ეწოდება ქვექსელის ნიღაბი. 

IPv4-მისამართის 32 ბიტი თეორიულად 232, ანუ 4294967296 მისამართს იტევს ( 4.3 

მილიარდამდე) - ბოლო წლებში მომრავლებული ქსელური მოწყობილობების წყალობით 

არსებობს IP-მისამართების დეფიციტი. 

IPv6 კი 128 ბიტიან ინფორმაციას შეიცავს და კოლოსალური რაოდენობის 

ქსელური მოწყობილობების დამისამართება შეუძლია (2128 , რაც 39 ნიშნა რიცხვია). 

ახლო მომავალში, ორივე - IPv4 და IPv6 სტანდარტი იქნება თანაარსებობის 

პირობებში. პრობლემა ისაა, რომ IPv6 ძველ მოწყობილობებთან არათავსებადია. თუ ერთ 

მშვენიერ დღეს, მთელი ინტერნეტი პროტოკოლის ახალ ვერსიაზე გადავა, ყველას ძველი 

ქსელური მოწყობილობის ახლით შეცვლა მოუწევს. IETF ქმნის სხვადასხვა 

პროტოკოლებს, რათა დაეხმაროს ქსელის ადმინისტრატორებს მოახდინონ მათი 

ქსელების მიგრაცია IPv6-ში. 

ინტერნეტ პროვაიდერი არის ორგანიზაცია, რომელიც უზრუნველყოფს 

მომხმარებელთა ჩართვას ინტერნეტში (მაგ. მაგთი, ჯეოსელი, სილქნეტი). 

Wi-Fi (ინგლ. wireless fidelity) - ლოკალურ ქსელში უსადენო კავშირის დამყარების 

ტექნოლოგია, რომელიც ზემაღალი / სანტიმეტრული ტალღების სიხშირეებს იყენებს. 

ინტერნეტ კავშირის მხოლოდ 1% ხორციელდება სატელიტით, დანარჩენი 99% კი 

წყალქვეშა კაბელებით ოკეანეების ფსკერზე (იხ. https://www.submarinecablemap.com/). 

ინტერნეტ-ბრაუზერი (ასევე ვებ ბრაუზერი ან უბრალოდ ბრაუზერი) 

წარმოადგენს პროგრამას, ტექნიკურად „HTTP კლიენტს“, რომელიც მომხმარებელს 

საშუალებას აძლევს „HTML დოკუმენტების“ ინფორმაციის ჩვენებას, ვებ-სერვერიდან ან 

ფაილური სისტემიდან. დღეისთვის მრავალი ინტერნეტ-ბრაუზერი არსებობს, მათ 

შორის პერსონალური კომპიუტერებისთვის ყველაზე პოპულარულია: Google Chrome, 

Opera, Internet Explorer, Mozilla Firefox, Safari. 

ვებგვერდი - საიტის შემადგენელი ნაწილი. იგი წარმოადგენს ინფორმაციის 

წყაროს და შეიცავს ჰიპერტექსტებს, რომელთა საშუალებითაც ხდება სხვადასხვა 

https://www.submarinecablemap.com/
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დოკუმენტის მოძიება და კავშირი. ყველაზე ხშირად საიტი დაწერილია HTML ან XHTML 

ვებ პროგრამირების ენაზე და ხელმისაწვდომია ვებბრაუზერის საშუალებით. 

ელექტრონული ფოსტა (e-mail) - კომპიუტერულ ქსელში წერილების მიღებისა და 

გაგზავნის ტექნოლოგია. წერილების გაგზავნა ხდება Simple Mail Transfer Protocol-ის 

საშუალებით. გლობალური დომენური სახელების სისტემის (DNS) შექმნის შემდეგ 

ადრესატის მისამართად შესაძლებელი გახდა დომენური სახელის გამოყენება, 

მაგალითად user@example.com - მომხმარებელი user, კომპიუტერზე example.com. 

ახლა, წერილი პირდაპირ აღარ ხვდებოდა ადრესატის კომპიუტერში, არამედ იგი 

თავსდებოდა სერვერში და მიმღები სერვერიდან იღებდა თავის წერილებს POP3, IMAP 

და RCP პროტოკოლების საშუალებით.  

დღეისათვის დომენური სახელი აღარ გამოიყენება კონკრეტული კომპიუტერის 

მისამართად, იგი მხოლოდ საფოსტო დომენად იქცა და მასზე სხვადასხვა სერვერი 

შეიძლება იყოს პასუხისმგებელი. 

ვირუსები და მათთან ბრძოლა. კომპიუტერული ვირუსი  წარმოადგენს 

კომპიუტერულ პროგრამას, რომელიც სხვა პროგრამებისგან იმით განსხვავდება, რომ 

შეუძლია გამრავლდეს და დააზიანოს კომპიუტერის პროგრამული (ზოგჯერ 

აპარატურულიც) უზრუნველყოფა. 

ვირუსები ვრცელდებიან ინტერნეტით. მაგალითად ვებსაიტებზე შესვლისას, 

მესენჯერების გამოყენებისას, რაიმე პროგრამის გადმოწერისას, ელფოსტის მიღებისას და 

აგრეთვე ინფორმაციის მატარებელი მოწყობილობებით : ვინჩესტერი, მობილური, ფლეშ 

დრაივი, ფლოპი დისკეტა და CD/DVD. 

კომპიუტერული ვირუსი რამოდენიმე კატეგორიად იყოფა. მათგან ყველაზე 

პოპულარულები კი არიან: 

ჩვეულებრივი ვირუსი - კომპიუტერის მუშაობის მოდიფიკაცია, მრავლდება 

თავისით, სჭრიდება პროგრამა, რომელზეც მიმაგრდება; 

Worm (ვორმი, ჭიაყელა) -  ჩვეულერივი ვირუსისაგან იმით განსხვავდება, რომ არ 

სჭირდება ჰოსტ პროგრამა; 

Roorkit - მალავს ზიანის მომტანი პროგრამის პროცესს, პრივილეგირებული 

წვდომა აქვს კომპიუტერთან; 

Trojan Horse (ტროას ცხენი) - პროგრამა, რომელიც ირწმუნება, რომ გააკეთებს ერთს 

და სინამდვილეში აკეთებს მეორეს. ქმნის უკანა კარებს, რომელიც ჰაკერს საშუალებას 

აძლევს წვდომა ჰქონდეს მსხვერპლის კომპიუტერის სისტემასთან; 

Spyware (შპიონი) - პროგრამა, რომელიც დაინსტალირების შემდეგ მალულად 

აგროვებს ინფორმაციას მომხმარებლის კომპიუტერიდან; 

Adware (სარეკლამო) - პროგრამული პაკეტი, რომელიც არალეგალურ რეკლამებს 

აწარმოებს. 

ვირუსის „აკიდების“ მიზეზი შეიძლება გახდეს: დაკრეკილი ვინდოუსი, 

დაკრეკილი პროგრამული უზრუნველყოფა, არალეგალური კონტენტის შემცველი 

საიტების თვალიერება, ვარეზები, კრეკების და სერიულების საიტები, სისტემის 

განახლებების გათიშვა, მოძველებული პროგრამული უზრუნველყოფა, ანტივირუსის და 

ბრანდმაუერის უქონლობა კომპიუტერში, სხვისი მოტანილი ინფო რმაციის შემცველი 

მოწყობილობის მიერთება, ოპერაციული სისტემის არასწორი კონფიგურაცია, ხვრელები 

პროგრამულ და ზოგჯერ აპარატურულ უზრუნველყოფაში და ა.შ. 
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თუ სისტემა ჭედავს, თუ ქსელში ზედმეტი ტრაფიკი გადის და ახლობლები 

გეუბნებიან რომ თქვენი ელფოსტით უცნაურ წერილებს იღებენ, ესეიგი ვირუსი გყავთ. 

ამის გაგება ანტივირუსითაც შეიძლება. ანტივირუსი წარმოადგენს კომპიუტერულ 

პროგრამას, რომლის ძირითადი ფუნქციაა ვირუსების პოვნა, აღმოჩენა და მოსპობა. 

არსებობს ბევრი კომპანია, რომელიც აწარმოებს ანტივირუსებს, მაგალითად ESET, 

LLC (http://www.eset.com/), ALWIL Software (http://www.avast.com/), Avira                              

(http://www.free-av.com/ ), Kaspersky Lab (http://www.kaspersky.com/ ). რაც შეეხება მათ 

შორის საუკეთესოს, ეს უკვე სხვა საკითხია. უნდა გაითვალისწინოთ ფაქტი, ვერცერთი 

ანტივირუსი ვერ დაიცავს თქვენს კომპიუტერს 100%-ით. 

ვირუსებისგან დასაცავად საჭიროა: 

• შეიძინეთ ლიცენზირებული პროგრამული უზრუნველყოფა; 

• ნუ დასვამთ უცხო ხალხს საკუთარ კომპიუტერზე; 

• ნუ გახსნით საეჭვო წერილებს, რომლებიც თქვენს ელფოსტაზე მოდის; 

• ნუ შეხვალთ საეჭვო რეპუტაციის საიტებზე; 

• ყველა ფაილი რასაც გადმოიწერთ, ანტივირუსით დაასკანერეთ; 

• ნუ დაგეზარებათ ვინდოუსის გადაყენება; 

• თუ თქვენი თავის იმედი არ გაქვთ მიმართეთ კომპეტენტურ პირს; 

• ნუ ენდობით ინტერნეტში ამა თუ იმ ახალი პროგრამული პროდუქტის 

რეკლამას. ნუ გადმოწერთ ნურაფერს სანამ არ დაეკითხებით ვინმე 

კომპეტენტურს ან არ დაასკანერებთ ანტივირუსით; 

• გაანახლეთ ოპერაციული სისტემა და პროგრამული უზრუნველყოფა და ა.შ. 

 

პრაქტიკული სამუშაოები: კომპიუტერის IP მისამართის და ინტერნეტის 

სისწრაფის განსაზღვრა; ინტერნეტ კავშირის მართვა; ელექტრონული ფოსტით 

სარგებლობა; ვებსაიტის შექმნის ძირითადი ეტაპები; საძიებო სისტემებით სარგებლობა; 

ანტივირუსების გამოყენება; Windows 10-ის უსაფრთხოების სისტემის გამოყენება. 
 

თემა 4. MS Word-ის File, Home და Layout მენიუების განხილვა 

Microsoft Office Word - ტექსტური რედაქტორია, რომელსაც აწარმოებს კორპორაცია 

Microsoft. იგი პირველად გამოვიდა 1983 წელს, Xenix-ის სისტემებისათვის, 

სახელწოდებით „Multi-Tool Word“. Microsoft Office Word შედის Microsoft Office-ის პაკეტში. 

ამ სახელმძღვანელოში განხილულია MS Word 2016. 

ფუნქციების ფართო სპექტრის წყალობით ტექსტური პროცესორი Microsoft Word 

გვაგონებს მაგიდის საგამომცემლო სისტემას. პროგრამის ფუნქციურ შესაძლებლობათა 

შორის უნდა აღინიშნოს: 

• მთელი რიგი სხვადასხვა ზომის შრიფტებისა და მოხაზულობის სიმბოლოების 

არსებობა; 

• ტექსტის გამოყოფის საშუალებების არსებობა; 

• აბზაცების პარამეტრების, ხაზთა შორის ინტერვალების დაყენების საშუალება; 

• მართლწერის, სინონიმების შერჩევის ავტომატური შემოწმების საშუალება; 

• გვერდების ავტომატური დანომვრა და სიტყვების ახალ ხაზზე გადატანა; 

• ცხრილებისა და ჰიპერტექსტის შექმნის საშუალება ბმულებით და ბევრი სხვა. 

http://www.eset.com/
http://www.avast.com/
http://www.free-av.com/
http://www.kaspersky.com/
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File მენიუს ბრძანებები. File მენიუ მოთავსებულია ფანჯრის ზედა მარცხენა 

კუთხეში და მისი მენიუ შეიცავს ყველა იმ სტანდარტულ ბრძანებას, რომელიც საჭიროა 

ნებისმიერ დოკუმენტთან სამუშაოდ. File მენიუს ბრძანებებია: 

• Info  - ინფორმაცია დოკუმენტის შესახებ; 

• New (Ctrl+N) - ახალი დოკუმენტის შექმნა; 

• Open (Ctrl+O)  - არსებულის გახსნა; 

• Save (Ctrl+S) - შენახვა/დამახსოვრება; 

• Save As - პირველადი შენახვა; 

• Print (Ctrl+P) - ბეჭდვა; 

• Share - გაზიარება; 

• Export - ფაილის ტიპის შეცვლა; 

• Close - დახურვა; 

• Account - საკუთარი ანგარიშის გახსნა; 

• Options - პარამეტრების რედაქტირება. 

Home მენიუს ბრძანებები. Clipboard ჩანართის Cut (მონიშნული ტექსტის ამოჭრა), 

Copy (მონიშნული ტექსტის კოპირება - ბუფერში გადატანა) და Paste (ბუფერიდან 

ტექსტის ჩასმა) ბრძანებების შესრულება შესაძლებელია მონიშნული ტექსტის 

კონტექსტური მენიუდანაც. სტანდარტულად ბუფერი მუშაობს ერთ ფრაგმენტთან, 

მაგრამ გაცვლის ბუფერის (Clipboard) გამოყენებით შესაძლებელია ერთდროულად მასში 

ოცდაოთხამდე სხვადასხვა ტიპის ობიექტი მოთავსდეს. გაცვლის ბუფერის გააქტიურება 

შესაძლებელია Home ჩანართის, Clipboard ჯგუფის დიალოგური ფანჯრის ღილაკით. 

Home მენიუს Font ქვემენიუ. ტექსტთან მუშაობისას შრიფტის პარამეტრების 

შესაცვლელად გამოიყენება Home მენიუს Font ქვემენიუს ბრძანებები: მაგალითად, 

შრიფტის არჩევა ხდება Font ჩამოსაშლელი სიიდან, ხოლო ზომის შერჩევა ხდება ამავე 

ჩანართის Font Size მმართველი ელემენტიდან. 

Home მენიუს Paragraph ქვემენიუ. აბზაცი არის ტექსტის მონაკვეთი Enter-იდან 

Enter-ამდე და მისი პარამეტრების მართვა შესაძლებელია Home ჩანართის Paragraph 

ჯგუფის ელემენტებით, აგრეთვე Layout/Paragraph დიალოგური ფანჯრიდან და მინი 

პანელიდან. შესაძლებელია აბზაცის პარამეტრების დაყენება სახაზავით. სახაზავის 

გამოჩენა-დამალვა ხდება View მენიუს Show ჩანართიდან Ruler გადამრთველით. 

ტექსტთან მუშაობის დროს ხშირად საჭიროა აბზაცების პარამეტრების გამოყენება. 

ეს პარამეტრებია: სააბზაცო შეწევები, აბზაცის სტრიქონებს შორის ინტერვალი, აბზაცის 

შეფერადება, აბზაცის ჩარჩო, აბზაცებს შორის დაცილება. 

სააბზაცო შეწევები. სააბზაცო შეწევა განსაზღვრავს მის დაშორებას ფურცლის 

კიდედან. შეწევის პარამეტრების დაყენება შესაძლებელია Paragraph ჯგუფის 

დიალოგური ფანჯრიდან. Decrease Indent და Increase Indent მმართველი ელემენტებით 

ხდება მთლიანი აბზაცის შეწევა მარჯვნიდან და პირიქით. 

აბზაცის ჩარჩოები. დოკუმენტთან მუშაობის დროს რომელიმე ფრაგმენტზე 

ყურადღების გამახვილების მიზნით შესაძლებელია გამოყენებულ იქნას აბზაცის 

ჩარჩოები და შეფერადება (Borders and Shading). ჩარჩოების გასაკეთებლად უნდა 

მოინიშნოს ფრაგმენტი და Home/Paragraph/Borders მმართველი ელემენტის ჩამოსაშლელ 

ისარზე დაჭერით გამოვა იმ ჩარჩოების ვარიანტები. 
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აბზაცის ფონი. აბზაცის ფონის შესაცვლელად გამოიყენება ელემენტი Shading 

(შეფერადება). თავიდან არჩეულია თეთრი ფონი. ფონის ფერის შესაცვლელად 

მოინიშნება აბზაცი და Home/Paragraph/Shading-ის ჩამოსაშლელი ისრით გამოსულ ფერთა 

პალიტრიდან შეირჩევა სასურველი ფერი. 

შრიფტის და აბზაცის პარამეტრების შეცვლა აგრეთვე შეიძლება Font და Paragraph 

დიალოგური ფანჯრებიდან, რომლებიც გამოიძახება შესაბამისი ჩანართების ქვედა 

მარჯვენა კუთხეში პატარა ღილაკზე დაწკაპუნებით ან კონტექსტური მენიუდან 

შესაბამისი ბრძანებით. ამ დიალოგური ფანჯრების ფუნქციების დიდი ნაწილი 

წარმოდგენილია  Home მენიუს შესაბამისი ჩანართის ღილაკებით. 

ტექსტში ფრაგმენტის მოძიება და შეცვლა. ტექსტთან მუშაობის დროს ზოგჯერ 

საჭიროა გარკვეული ფრაგმენტის მოძიება და მისი შეცვლა. ამ მოქმედების შესრულება 

ხდება - Home/Editing ჯგუფის Find - მმართველი ელემენტით; ფანჯრის Find what ველში 

ჩაიწერება საძიებელი ფრაგმენტი და Find Next ღილაკზე დაჭერის შემდგომ ტექსტში 

ერთმანეთის მიმდევრობით მოინიშნება და გამოიყოფა ამ ფრაგმენტის ყველა ვარიანტი. 

ტექსტში რომელიმე ფრაგმენტის სხვა ფრაგმენტით შესაცვლელად გამოიყენება 

Editing ჯგუფის Replace მმართველი ელემენტი. გამოსულ დიალოგურ ფანჯარაში - Find 

what ველში ჩაისმება შესაცვლელი ფრაგმენტი, ხოლო Replace with ველში მისი ახალი 

ვარიანტი. ტექსტში ყველა საჭირო ფრაგმენტის (სიმბოლოს) მოძებნა და შეცვლა 

ერთდროულად შესაძლებელია Replace All ბრძანებებით. 

Layout მენიუს ბრძანებების საშუალებით ხდება ფურცლის ზომის (Size) ან 

ფურცლის ორიენტაციის (Orientation - Portrate ან Landscape) შეცვლა, ტექსტის 

მინდვრების განსაზღვრა (Margins). აგრეთვე შეგიძლიათ გამოიყენოთ Page Setup 

დიალოგური ფანჯარა, რომლის გამოძახებაც შეიძლება Page Setup ჩანართის ქვედა 

მარჯვენა კუთხეში პატარა ღილაკზე დაწკაპუნებით ან ჰორიზონტალურ სახაზავზე 

ორჯერადი დაწკაპუნებით. 
 

პრაქტიკული სამუშაოები: ვორდის ძირითადი ფანჯრის განხილვა, ახალი 

დოკუმენტის შექმნა; დოკუმენტის ზომის, ორიენტაციის და მინდვრების განსაზღვრა; 

ტექსტის შეყვანა ან/და ტექსტის კოპირებით გადმოტანა სხვა დოკუმენტებიდან ან 

ინტერნეტიდან; ტექსტის მონიშვნა და გასწორება კიდეების მიმართ; შრიფტის, აბზაცის 

და მთელი ტექსტის პარამეტრების შეცვლა; დოკუმენტის შენახვა და ამობეჭდვა. 
 

თემა 5. MS Word-ის Insert მენიუს განხილვა 

Table. Word-ის დოკუმენტში შესაძლებელია ცხრილის შექმნა და მასში მარტივი 

გამოთვლების შესრულება. ძირითადად გამოიყენება სტრუქტურირებული ცხრილები. 

ცხრილთან მუშაობის დროს ლენტაზე ჩნდება ორი დამატებითი ჩანართი: Design და 

Layout. მენიუში არის ცხრილის შექმნის რამდენიმე ვარიანტი: 

1. ცხრილის შექმნა სასურველი რაოდენობის სვეტის და სტრიქონის მონიშვნით. 

Insert ჩანართის Tables ჯგუფის Table მმართველი ელემენტში სასურველი რაოდენობის 

სვეტის და სტრიქონის მონიშვნით. 

2. Insert Table ბრძანებით გამოსულ დიალოგიურ ფანჯარაში მიეთითება საჭირო 

სვეტებისა (Number of columns) და სტრიქონების (Number of rows) რაოდენობა. 

Fixed column width - მიეთითება ფიქსირებული სიგანე სვეტებისათვის. 
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AutoFit to contents - სვეტის სიგანე დაფიქსირდება მასში შეტანილი ტექსტის ზომის 

მიხედვით. 

Autofit to window - ცხრილი გაიშლება სამუშაო ფანჯრის მთელ არეში. 

ამის გარდა კიდევ არსებობს ცხრილის შექმნის ოთხი მეთოდი: 

• ცხრილის დახაზვა ფანქრით; 

• ცხრილის შექმნა მონიშნული ტექსტის საფუძველზე; 

• ცხრილის შექმნა ექსელის სამუშაო არეში; 

• ცხრილის შექმნა მზა შაბლონის საფუძველზე. 

ცხრილის სვეტების და სტრიქონების ზომების შეცვლა შესაძლებელია: მაუსით 

ცხრილის საზღვრის ხაზების გადაწევით მარჯვნივ ან მარცხნივ, ზევით ან ქვევით. 

ერთდროულად სტრიქონებისა და სვეტების პროპორციულად გაზრდა ან 

დაპატარავება შესაძლებელია ცხრილის მარჯვენა ქვედა კუთხეში მოთავსებული 

მარკერის - პატარა თეთრი ოთხკუთხედის საშუალებით. 

შეიძლება ცხრილის რედაქტირება: სტრიქონების ამოგდება, ჩამატება, რიცხვითი 

მონაცემების შეტანა-რედაქტირება, სვეტების ამოგდება, დამატება. შესაბამისად 

შეიცვლება დიაგრამის სახე. 

Picture. Insert/Illustrations→Picture - ფაილიდან გრაფიკული გამოსახულების 

ჩასასმელად გამოიყენება Picture მმართველი ელემენტი. მისი გააქტიურების შედეგად 

გამოსული დიალოგური ფანჯრიდან ხდება სასურველი ფაილის არჩევა. სურათის 

Format-ჩანართიდან შეგვიძლია ვარეგულიროთ სურათის სხვადასხვა პარამეტრები - 

კონტრასტი, სიმკვეთრე, ზომა და ორიენტაცია. შესაძლებელია მხატვრული ეფექტების 

დამატება (Format/Adjust), სურათის ჩარჩოში ჩასმა (Format/Picture Styles), სურათის 

პოზიციისა და ტექსტის განლაგების შერჩევა (Format/Arrange→Position  და Format/Arrange 

→Wrap Text).  ამ პარამეტრების შეცვლა აგრეთვე შესაძლებელია სურათზე კონტექსტური 

მენიუდან შესაბამისი ბრძანებების შესრულებით. 

Online Pictures. Insert/Illustrations→Online Pictures - მისი არჩევით ეკრანის მარჯვენა 

მხარეს ჩნდება მის ობიექტებთან სამუშაო არე. კოლექციაში სურათები დალაგებულია 

თემატიკის მიხედვით, ამიტომ Search for ველში იწერება შესაბამისი სურათის საგასაღებო 

სიტყვა და Go ღილაკით ხდება ძებნა, რის შედეგადაც შესაბამისი სიტყვის სურათების 

კოლექცია გამოჩნდება და მასზე მაუსის მარცხენა ღილაკზე დაწკაპუნებით ან 

გადათრევით იგი ჩაჯდება დოკუმენტში. ძებნისას ადგილმდებარეობის 

დასაკონკრეტებლად გამოიყენება Search in ველი, ხოლო გრაფიკული ობიექტის 

კონკრეტული ტიპის ძებნისათვის - Results should be. 

Shapes. Insert/Illustrations→Shapes - გამოიყენება გეომეტრიული ფიგურების 

შესაქმნელად. მმართველი ელემენტის ისარზე დაწკაპუნებით ჩამოიშლება ჯგუფებად 

დალაგებულ მზა გეომეტრიულ ფიგურათა გალერეა, საიდანაც ხდება ფიგურის არჩევა და 

მაუსის საშუალებით დოკუმენტში ჩახატვა (ჩასმა) და მათი დაჯგუფება. 

SmartArt. Insert/Illustrations→SmartArt - საშუალებას იძლევა სწრაფად შეიქმნას 

პროფესიული დიზაინის სხვადასხვა სქემები. სასურველი სქემის არჩევა ხდება Insert 

ჩანართის Illustrations ჯგუფის SmartArt მმართველი ელემენტის გააქტიურებით გამოსულ 

დიალოგურ ფანჯარაში, რომლის მონიშვნის შემდეგ ქვედა პანელზე გამოდის ამ 

ელემენტის მოკლე აღწერა. SmartArt-ის დიალოგური ფანჯარა დაყოფილია რვა 
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კატეგორიად, რომლებიც სხვადასხვა ტიპის ინფორმაციის წარმოსადგენადაა 

განკუთვნილი. 

დიაგრამების აგება და ჩასმა (Chart). დიაგრამა გამოიყენება ცხრილური 

მონაცემების გრაფიკული წარმოდგენისთვის. მის ასაგებად პირველ ეტაპზე უნდა 

შევქმნათ ცხრილი და კურსორი დავაფიქსიროთ დიაგრამის ჩასმის ადგილას და 

დავაჭიროთ ღილაკს Insert → Chart, რის შედეგადაც ეკრანზე გამოვა დიალოგური 

ფანჯარა, რომლის მარცხენა ნაწილში მოცემულია დიაგრამის შაბლონები, ხოლო 

მარჯვნივ შესაბამისი სახეობები. 

Word-ს 15 სხვადასხვა ტიპის დიაგრამა აქვს: Column, Line, Pie, Bar, Area, XY(Scatter), 

Stock, Surface, Radar, Treemap, Sunburst, Histogram, Box & Whisker, Waterfall, Combo. 

გახსნილ Insert Chart ფანჯარაში აირჩიეთ შესაბამისი ტიპისა და სტილის 

დიაგრამა, დააჭირეთ OK-ს. გამოსულ Excel-ის ფანჯარაში ჩაწერეთ ან კოპირებით ჩასვით 

თქვენი ცხრილის მონაცემები. 

Text Box. დოკუმენტში ნებისმიერ ადგილზე ტექსტის განსათავსებლად, ასევე 

ტექსტისა და ობიექტების დასაჯგუფებლად, ტექსტის ორიენტაციის შესაცვლელად, 

ხშირად გამოიყენება მმართველი ელემენტი Text Box. მასში შესაძლებელია ასევე ნახატის, 

ფიგურის, ცხრილის ჩასმა. იგი მოთავსებულია Insert/Text ჯგუფში. აქვე არის Text Box-ის 

მზა შაბლონების კოლექცია. Text Box-ის მონიშვნისას ლენტაზე ჩნდება დამატებითი 

კონტექსტური ჩანართი Text Box Tools/Format, საიდანაც შეიძლება მისი პარამეტრების 

კორექტირება: ზომის შემცირება-გადიდება მარკერების საშუალებით, ფერების ჩასხმა, 

გარეთა კონტურის მოხსნა, გადაადგილება ტექსტში და ა.შ. 

ანუ Text Box-თან სამუშაო ბრძანებები გრაფიკულ ობიექტებთან სამუშაო 

ბრძანებების თითქმის ყველა ზემოთგანხილული ბრძანებების ანალოგიურია. 

Text Box-ის შიგნით მოთავსებული ტექსტის დაფორმატება არანაირ გავლენას არ 

ახდენს გარემომცველ ტექსტზე. 

Text Box-ის წაშლა: იგი მოინიშნება და კლავიშით Delete მოხდება მისი წაშლა 

შიგთავსითურთ. 

WordArt. WordArt არის Insert/Text ჯგუფის ელემენტი, რომლის საშუალებითაც 

ტექსტის ფრაგმენტის ჩაწერა ხდება გრაფიკული სახით. მისი გააქტიურებით გამოდის 

WordArt-ის გალერეა, საიდანაც შეირჩევა სასურველი ვარიანტი. 

შემდეგ ეტაპზე ხდება შრიფტის და ზომის მითითება და სათანადო ტექსტის 

ჩაწერა. WordArt-ით შექმნილი ტექსტის მონიშვნისას ჩნდება ჩანართი WordArt 

Tools/Format, რომლის მმართველი ელემენტებითაც შესაძლებელია მისი ფორმატირება. 

ასო-ნიშანი. ეს ეფექტი ხშირად გამოიყენება აბზაცის პირველი სიმბოლოს 

გასაფორმებლად. Insert/Text/ ჯგუფის Drop Cap ღილაკის ჩამოსაშლელ მენიუში მოხდება 

არჩევა, თუ როგორი მდებარეობა ექნება პირველ ასოს. შესაძლებელია ასო-ნიშნის 

პარამეტრების რედაქტირება. ამისათვის საჭიროა მოინიშნოს აბზაცი, Drop Cap-ის 

ჩამოსაშლელ ისარზე დაწკაპუნებით და Drop Cap Option-ის არჩევის შედეგად გამოსულ 

ფანჯარაში ასო-ნიშნისთვის შეიძლება სასურველი პარამეტრების დაყენება, ასევე 

სასურველი ზომისა და მდებარეობის შერჩევა. 

ზედა და ქვედა კოლონტიტულების ჩასმა, გვერდების გადანომრვა. ტექსტში 

კოლონტიტულების ჩასასმელად გამოიყენება Insert ჩანართის Header & Footer ჯგუფი. 

აქედანვე ხდება დოკუმენტის გვერდების გადანომრვა (Page Number). დოკუმენტში 

შესაძლებელია განსხვავებული კოლონტიტულების შექმნა როგორც კენტი და ლუწი 
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ნომრიანი გვერდებისთვის, აგრეთვე პირველი გვერდისთვისაც. ამ რეჟიმების 

ჩასართავად გამოიყენება Page Layout ჩანართის Page Setup ჯგუფის დიალოგური ფანჯრის 

Layout ჩანართი. 

Different odd and even - დოკუმენტის ლუწ და კენტ ნომრიანი გვერდებისთვის 

განსხვავებული კოლონტიტულების შექმნის რეჟიმის ჩართვა. 

Different first page - დოკუმენტის პირველი გვერდისთვის განსხვავებული 

კოლონტიტულის შექმნა. 

Header - მმართველი ელემენტის გააქტიურებით ჩამოშლილ გალერეაში ზედა 

კოლონტიტულის მზა შაბლონებიდან შესაძლებელია ნებისმიერის არჩევა, Edit Header-ის 

საშუალებით კოლონტიტულების რედაქტირება, ხოლო ბრძანებით Remove Header - 

კოლონტიტულის წაშლა. 

Footer-ის საშუალებით ხდება ქვედა კოლონტიტულის ჩასმა. 

Page Number - დოკუმენტის გვერდების გადანომრვა. Top of Page, Bottom of Page, 

Page of Margins, Current Position - განსაზღვრავს ნომრის მდებარეობას გვერდზე. 

Remove Page Numbers - ნომერაციის წაშლა. 

Format Page Numbers - ნუმერაციის ფორმატის არჩევა და საწყისი ნომრის 

მითითება. 

სიმბოლოების ჩასმა. თუ ტექსტში უნდა ჩაისვას ისეთი სიმბოლო, რომელიც 

კლავიატურაზე არ არის, მაშინ შესაძლებელია გამოყენებული იქნას Insert ჩანართის 

Symbols ჯგუფის Symbol მმართველი ელემენტი. გამოსულ ფანჯარაში მოცემულლია 

უფრო ხშირად გამოყენებადი სიმბოლოები. თუ სასურველი სიმბოლო არა არის ამ 

ფანჯარაში, მაშინ More Symbols ბრძანების არჩევით გამოდის დიალოგური ფანჯარა, 

რომელშიც ხდება სასურველი სიმბოლოს შემცველი შრიფტის არჩევა. 

ტექნიკური სიმბოლოების ჩასასმელად გამოიყენება შრიფტი Symbol, ხოლო 

სურათების სიმბოლოებისათვის კი შრიფტები: Windings, Windings2, Windings3. 

თარიღის და დროის ჩასმა. დოკუმენტთან მუშაობის დროს ხშირად საჭირო ხდება 

თარიღისა და დროის ჩასმა. ეს შესაძლებელია Insert ჩანართის Text ჯგუფის Date & Time 

მმართველი ელემენტით. 

Date and Time დიალოგურ ფანჯარაში ხდება სასურველი დროის ფორმატის 

არჩევა, ამავე ფანჯარაში Update Automatically ჩართვის შემთხვევაში, დოკუმენტის 

ყოველი გახსნისას თარიღი და დრო ავტომატურად განახლდება. 

 

პრაქტიკული სამუშაოები: სხვადასხვა გრაფიკული ობიექტების შექმნა და მათი 

თვისებების შეცვლის საშუალებების შესწავლა. 

 

თემა 6. MS Word-ში ტექსტის ფორმატირების ეფექტური მეთოდები: სტილებთან 

მუშაობა, Design მენიუს ბრძანებები, სატიტულო გვერდის და სარჩევის დამატება, 

დოკუმენტის დაბეჭდვა 

სტილებით ფორმატირება ტექსტის პარამეტრების შეცვლის ავტომატიზების 

საშუალებას იძლევა, რაც ძალიან მნიშვნელოვანია დიდ დოკუმენტებთან მუშაობის 

დროს. სტილების პანელზე (Styles) წარმოდგენილია ღილაკები ტექსტის სხვადასხვა 

რეჟიმში შესაყვანად. მაგალითად, Normal - არის ჩვეულებრივი ტექსტის შეყვანის რეჟიმი, 

Book Title - წიგნის სათაურის რეჟიმი, Title - სათაურის რეჟიმი, Subtitle - ქვესათაურის 
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რეჟიმი, Heading 1 - პირველი დონის სათაურის რეჟიმი, Heading 2 - მეორე დონის 

სათაურის რეჟიმი, Strong - გამოკვეთილი ტექსტის რეჟიმი და ა. შ. სტილის პარამეტრების 

შეცვლა ხდება დიალოგური ფანჯრიდან Modify Style, რომელიც გამოიძახება სტილის 

ღილაკის კონტექსტური მენიუდან ბრძანებით Modify. იმ შემთხვევაში, თუ შესაცვლელი 

პარამეტრი არ არის გამოტანილი ამ ფანჯარაში, შეგიძლიათ ისარგებლოთ Format 

ღილაკით, რომელიც მოთავსებულია Modify Style ფანჯრის ქვედა მარცხენა კუთხეში. 

სტილის პარამეტრების შეცვლის შემთხვევაში ამ სტილით აკრეფილი ტექსტი 

ავტომატურად შეიცვლება მთელ დოკუმენტში ახალი პარამეტრების შესაბამისად. 

Design მენიუში წარმოდგენილია სტილების პარამეტრების სტანდარტული 

ვარიანტები. 

ახალი სტილის შესაქმნელად შეგვიძლია ბოლომდე ჩამოვშალოთ ფანჯარა და 

დავაწკაპუნოთ ბრძანებაზე Create a Style, სადაც ველში Name უნდა შევიყვანოთ ახალი 

სტილის სახელი. 

სტილის ამოშლა სტილების გალერეიდან ხდება ბრძანებით Remove from Style 

Gallery. 

ძირითადი ტექსტის და სათაურების დაფორმატების გაადვილების მიზნით ჯერ 

დავაყენოთ შესაბამისი სტილების პარამეტრები. მერე უნდა სათითაოდ დავამუშაოთ 

ყველა სათაური: მოვნიშნოთ და სასურველი სტილის ღილაკზე დაწკაპუნებით 

მივანიჭოთ ეს სტილი მონიშნულ სათაურს.  

როცა ვორდის დოკუმენტი არის დიდი და ბევრი თავისგან და ქვეთავისგან არის 

შემდგარი, საკმაოდ რთულია სარჩევის შედგენა და მასში არსებული გვერდების 

ნომრების მუდმივად ტექსტთან შესაბამისობაში მოყვანა. ამიტომ სტილების გამოყენება 

მნიშვნელოვნად გაგვიადვილებს სარჩევის შექმნას. 

სარჩევის შექმნა. როცა ყველა თავის და ქვეთავის სათაურს დავაფორმატებთ 

სტილების საშუალებით, კურსორი ავიტანოთ დოკუმენტის იმ ადგილას სადაც სარჩევის 

ჩასმა გვსურს და References მენიუში References→Table of Contents ღილაკის ჩამოსაშლელი 

სიიდან ავირჩიოთ სარჩევის სასურველი ვარიანტი. 

სარჩევის ჩასმის შემდეგ, შეგვიძლია მისი სათაური შევცვალოთ ჩვენი 

სურვილისამებრ. სარჩევის მერე, სასურველია ტექსტი შემდეგი გვერდიდან დაიწყოს. 

ამის გასაკეთებლად სარჩევის შემდეგ ჩასვით გვერდის გადატანის სიმბოლო. 

დოკუმენტის კრეფისას ხანდახან სასურველია სარჩევის განახლება, იმისთვის, 

რომ იგი რეალურად ასახავდეს მიმდინარე მდგომარეობას. ამისთვის საჭიროა სარჩევზე 

დავდგეთ კურსორით და მენიუს შემდეგ პუნქტებს დავაჭიროთ: Update Table. 

ასეთი ტექნიკით ჩვენი სარჩევი მუდმივად განახლებული იქნება და ხელით არ 

მოგვიწევს გვერდების ნომრების ჩასწორება. 

სატიტულო გვერდის შექმნა. სატიტულო გვერდის შესაქმნელად გამოიყენება 

Insert ჩანართის Pages ჯგუფის Cover Page მმართველი ელემენტი, რის შედეგადაც გამოვა 

სატიტულო გვერდების გალერეა. 

გალერეიდან შეირჩევა სასურველი დიზაინის სატიტულო გვერდი, რომლის 

ფორმატირებაც შესაძლებელია. ასევე შეიძლება ახალი სატიტულო გვერდის შექმნა და 

შენახვა. შენახვა ხდება ბრძანებით Insert/Pages/Cover Page→Save selection to Cover Page 

Gallery. 

სატიტულო გვერდის წაშლა შესაძლებელია Insert ჩანართის Pages ჯგუფის Cover 

Page→Remove Current Cover Page ბრძანების საშუალებით. 
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დოკუმენტის ფონები - Page Background. Design მენიუს Page Background ჯგუფის   

მმართველი ელემენტების საშუალებით შესაძლებელია ფურცლისთვის და მთლიანობაში 

დოკუმენტისთვის სხვადასხვა ეფექტების მიცემა. 

Watermark - წყალნიშანი. შესაძლებელია ფონად გაკეთდეს სურათი, ან შეიქმნას 

ტექსტი. 

Page Color - ფურცლის გაფერადება სხვადასხვა ტიპის დამატებითი ეფექტებით. 

Page Borders - ფურცლისთვის ჩარჩოების გაკეთება. Setting განყოფილებიდან 

ხდება ჩარჩოს ტიპის განსაზღვრა: 

• None - ჩარჩოსთვის ჩარჩოს მოხსნა; 

• Style - ხაზის ტიპის შერჩევა; 

• Color - ხაზის ფერის შერჩევა; 

• Width - ხაზის სისქის შერჩევა. 

Art - ჩარჩოსთვის ხაზის ნაცვლად გრაფიკული გამოსახულების გამოყენება. 

დოკუმენტის ბეჭდვა. ბეჭდვის პარამეტრების მომართვისათვის გამოიყენება 

ბეჭდვის დიალოგური ფანჯარა (გამოიძახება ბრძანებით File→Print ან კლავიშთა 

კომბინაციით Ctrl+P), სადაც 

Name - პრინტერის დასახელებაა; 

Page range - დასაბეჭდი გვერდების თანმიმდევრობა; 

All - ყველა გვერდის ბეჭდვა; 

Current page - მიმდინარე(აქტიური) გვერდის ბეჭდვა; 

Pages - მიეთითება დასაბეჭდი გვერდების ნომრები(ამორჩევით). Number of copies 

- ასლების რაოდენობა; 

Collate - პარამეტრის ჩართვის შემთხვევაში იცვლება ასლების ამობეჭდვის 

რიგითობა; 

Print - არჩეული დიაპაზონიდან სასურველი გვერდების ბეჭდვა: 

• All pages in range - ყველა გვერდის დაბეჭდვა თანმიმდევრობით  

• Odd pages - კენტნომრიანი გვერდების ბეჭდვა; 

• Even pages - ლუწნომრიანი გვერდების ბეჭდვა; 

• Paper per sheet - დასაბეჭდი გვერდების რაოდენობა ფურცელზე. 

დოკუმენტის ბეჭდვისწინა დათვალიერება. ბეჭვდის წინ დოკუმენტის 

დასათვალიერებლად გამოიყენება წინასწარი დათვალიერების რეჟიმი Print Preview. 

ამ რეჟიმში დოკუმენტი ზუსტად ისე აისახება, როგორც ამოიბეჭდება ქაღალდზე. 

მასში ტექსტის რედაქტირება შეუძლებელია. 

 

პრაქტიკული სამუშაოები: საშუალო ზომის (40-50 გვერდი) დაუფორმატებელი 

ტექსტის საფუძველზე ბროშურის შექმნა, სატიტულო გვერდის და სარჩევის დამატება, 

ფონის პარამეტრების დაყენება. 
 

თემა 7. Review, View მენიუები. ცხრილებთან მუშაობა 

Review მენიუს ბრძანებები. 

Spelling&Grammar. ორთოგრაფიული შეცდომებისა და გრამატიკული წყობის 

შემოწმება-კორექტირება ტექსტში; 

Thesaurus. ამორჩეული სიტყვისათვის მოძებნის მის შესატყვისებს, მისი 

ჩანაცვლების შესაძლებლობით (Shift+F7); 
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Word Count. სიტყვების, სიმბოლოების, პარაგრაფებისა და სტრიქონების რიცხვის 

დათვლა. ამ ოპერაციის შესრულება შეიძლება აგრეთვე სტატუს - ხაზიდან (გვერდის 

ქვემო საზღვარზე), მასზე დაწკაპუნებით; 

Translate. ამორჩეულ ტექსტს თარგმნის სხვა ენაზე; 

Language. იმ ენის დაყენება, რომელზედაც გვინდა ორთოგრაფული შეცდომების 

კორექტირება; 

New Comment. ახალი კომენტარის ჩასმამონიშნულ ადგილას; 

Delete. ამორჩეული კომენტარის წაშლა; 

Previous. წინა კომენტარზე გადასვალა; 

Next. შემდგომ კომენტარზე გადასვლა; 

Track Changes. დოკუმენტში ცვლილებების (ფორმატირების, ჩასმის წაშლის ...) 

კვალდაკვალ დაფიქსირება; 

Simple Markup. ირჩევს როგორ აჩვენოს ცვლილება; 

Show Markup. სპეციალური მოსანიშნის ჩვენება; 

Reviewing Pane. დასათვალიერებელი პანელის ჩართვა; 

Accept. დასტური (თანხმობა) დოკუმენტში ყველანაირ ცვლილებაზე; 

Reject. ყველანაირი ცლილებების ამოგდება დოკუმენტიდან; 

Previous. წინა ცვლილებაზე გადასვლა, იმ მიზნით დავეთანხმოთ თუ არა 

ცვლილებებს; 

Next. წინა ცვლილებაზე გადასვლა; 

Compare. ადარებს ერთმანეთს დოკუმენტის სხვასხვა ვერსიებს; 

Restict Editting. შეზღუდული მიმართვის დაწესება დოკუმენტისათვის, 

უსაფრთხოების მიზნით. 
 

View მენიუს ბრძანებები. 

Print Layout. დოკუმენტის ჩვენება როგორც ამოსაბეჭდი გვერდი; 

Read Mode. დოკუმენტის უკეთ წაკითხვის მიზნით ჩვენება; 

Web Layout. დოკუმენტის ჩვენება ვებ გვერდის ფორმატში; 

Outline. დოკუმენტის ჩვენება მაკეტურ რეჟიმში, შესაბამისი ინსტრუმენტების 

ჩვენებით; 

Draft. ტექსტის სამუშაო ვარიანტის ჩვენება ყოველგვარი დამატებების 

(კოლონტიტულები და სხვა) გარეშე; 

Ruler. სახაზავების ჩვენება (ზომების დასადგენად); 

Gridlines. დოკუმენტზე ხაზების (ბადის) დატანა; 

Navigation Pane. დოკუმენტის სექციებზე, სათაურებზე და გვერდებზე ნავიგაციის 

პანელი; 

Zoom. გადიდების მასშტაბი; 

100 %. დოკუმენტის ნორმალური ზომა (100%); 

One Page. ფანჯარაში მხოლოდ ერთი გვერდი ჩანს; 

Multiple Pages. დოკუმენტის ისეთი მასშტაბით ჩვენება, როცა გამოჩნდება ორი 

გვერდი; 

Page Width. დოკუმენტი ჩანს მთელ სიგანეზე; 

New Window.  მიმდინარე დოკუმენტს ახალ (დამატებით) ფანჯარაში; 
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Arrange All. ყველა გახსნილ ფანჯარას დააწყობს ერთმანეთის მიმდევრობით 

ჰორიზონტალურად; 

Split. დოკუმენტის გამყოფის დაყენება. დოკუმენტი იყოფა ორ ნაწილად, 

რომლებიც იმარტებიან ავტონომიურად. ე.ი. შესაძლებელია ერთდროულად უყუროთ 

დოკუმენტის სხვასხვა ნაწილს. 

 

ცხრილის ელემენტის დამატება. ცხრილთან მუშაობის დროს ზოგჯერ საჭიროა 

სვეტის, სტრიქონის ან უჯრედის დამატება, ამისათვის სამუშაო ცხრილის მონიშვნის 

შედეგად ლენტაზე გამოსული კონტექსტური მენიუს Layout ჩანართის Rows & Columns 

ჯგუფში შესაბამისი ბრძანების არჩევა. 

მაგალითად, სტრიქონების დასამატებლად საჭიროა მოინიშნოს იმდენი 

სტრიქონი, რამდენის დამატებაც არის საჭირო და არჩეულ იქნას ჩასამატებელი 

სტრიქონების მდებარეობა: მონიშნული სტრიქონების ზევით ან ქვევით (Insert Above ან 

Insert Below). ანალოგიურად ხდება სვეტებისათვისაც Layout/ Rows & Columns→Insert Left 

ან Insert Right. 

ცხრილის ელემენტის წაშლა. სვეტების და სტრიქონების წასაშლელად უმეტესად 

გამოიყენება კონტექსტური Layout ჩანართის Delete ბრძანება. ჩამოსაშლელი სიიდან 

ხდება წასაშლელი სტრიქონის ან სვეტის შესაბამისი ბრძანების არჩევა. კლავიატურიდან 

ცხრილის ელემენტების წასაშლელად გამოიყენება Backspaсe ღილაკი, ხოლო შიგთავსის 

გასუფთავებისათვის - Delete ღილაკი. 

ცხრილის სვეტის ან სტრიქონის ზომის შეცვლა. ცხრილის ელემენტების ზომების 

შეცვლა შესაძლებელია რამდენიმე მეთოდით: 

• მაუსით ცხრილის საზღვრის ხაზების გადაწევით მარჯვნივ ან მარცხნივ, ზევით 

ან ქვევით; 

• მონიშნული სვეტების სიგანის (სტრიქონების სიმაღლის) გათანაბრებისთვის 

გამოიყენება Layout/Cell Size→Table Column Width (Layout/Cell Size→Table Row 

Height); 

• ცხრილის სვეტების (სტრიქონების) გათანაბრება ხდება Layout/Cell 

Size→Distribute Columns (Rows) ბრძანებით. 

ერთდროულად სტრიქონებისა და სვეტების პროპორციულად გაზრდა ან 

დაპატარავება შესაძლებელია ცხრილის მარჯვენა ქვედა კუთხეში მოთავსებული 

მარკერის (პატარა თეთრი ოთხკუთხედი) საშუალებით. 

ცხრილის უჯრედების გაერთიანება (Merge Cells):  

• მონიშნული უჯრედებისთვის უნდა გააქტიურდეს კონტექსტური მენიუს 

ბრძანება Layout/Merge→Merge Cells. 

• მონიშნული უჯრედის რამდენიმე უჯრედიდ დასაყოფად (Split Cells) 

გამოიყენება ბრძანება Layout/Merge→Split Cells. გამოსულ დიალოგურ 

ფანჯარაში მიეთითება გაყოფის შედეგად მისაღები სვეტებისა და სტრიქონების 

რაოდენობა. 

ცხრილის გაყოფა. ცხრილის გაყოფისათვის გამოიყენება კონტექსტური Layout 

ჩანართის Merge /Split Table ბრძანება. ცხრილის გაყოფა მოხდება აქტიური სტრიქონიდან. 

ქვედა ცხრილისთვის აქტიური სტრიქონი გადაიქცევა პირველ სტრიქონად. 



20 
 

ცხრილის გასწორება ფურცელზე. ცხრილის კონტექსტური მენიუს Table 

Properties… ბრზანებით ან Layout/Table→Properties ბრძანებით გამოსულ დიალოგიურ 

ფანჯარაში Table ჩანართით განისაზღვრება, ცხრილის მდებარეობა ტექსტთან და 

ფურცლის კიდეებთან მიმართებაში. Table Properties დიალოგური ფანჯრის Row და 

Column ჩანართებიდან ხდება სტრიქონის და სვეტისათვის სასურველი სიმაღლის და 

სიგანის დაფიქსირება. Cell ჩანართიდან განისაზღვრება ტექსტის მდებარეობა უჯრედში. 

ცხრილის სათაურის სტრიქონის გადატანა ახალ ფურცელზე. დიდ ცხრილებთან 

მუშაობის დროს საჭირო ხდება სათაურის სტრიქონის გადატანა მომდევნო გვერდებზე. 

იმისათვის, რომ სათაურის სტრიქონი ავტომატურად აისახებოდეს ყველა ფურცელზე, 

საჭიროა კურსორი ჩაისვას ამ სტრიქონში, ან მოინიშნოს იგი და გააქტიურდეს ბრძანება 

Layout/Data→Repeat Header Rows. 

ცხრილში მონაცემების შეტანა. ცხრილის უჯრედში შეტანილი მონაცემების 

გასწორება ჰორიზონტალურად და ვერტიკალურად, აგრეთვე უჯრედში შეტანილი 

მონაცემების ორიენტაციის შეცვლა ხდება ცხრილის მონიშვნის შედეგად ლენტაზე 

გააქტიურებული კონტექსტური Layout ჩანართის, Alignment ჯგუფის ბრძანებების 

შესაბამისი ღილაკებით. 

 

პრაქტიკული სამუშაოები: დოკუმენტის ორთოგრაფიის შემოწმება; დოკუმენტის 

ხედის შეცვლა; რთული სტრუქტურის მქონე ცხრილების შექმნა (მეცადინეობების 

ცხრილი, ჩემპიონატის ცხრილი და ა. შ.). 
 

თემა 8. ელექტრონული პრეზენტაციების პროგრამა - MS Power Point 

ელექტრონული პრეზენტაციების პროგრამა MS Power Point წარმოადგენს 

MSOffice-საოფისე პროგრამების პაკეტში შემავალ პროგრამას, რომელიც ფართოდ 

გამოიყენება ისეთ საჯარო გამოსვლებში, როგორიცაა ლექცია, მოხსენება, სემინარები, 

კონფერენცია. კარგად გაფორმებული პრეზენტაცია აადვილებს მოხსენების შინაარსის 

აღქმას და უფრო საინტერესოს ხდის მას. პრეზენტაციის პროცესში ფართოდ გამოიყენება 

კომპიუტერული საშუალებები. 

Microsoft PowerPoint-ის გაშვება შესაძლებელია:  

1. სამუშაო მაგიდიდან შესაბამის იარლიყზე Microsoft PowerPoint მაუსის ორჯერ 

დაწკაპუნებით;  

2. ამოცანათა პანელის სასტარტო მენიუდან შემდეგი თანამიმდევრობით: 

Start→All apps→Microsoft Office→Microsoft PowerPoint.  

Microsoft PowerPoint-ს გააჩნია სტანდარტული ფანჯრის აგებულება, რომელიც 

შედგება შემდეგი ელემენტებისაგან: სათაურის ზოლი, მენიუს ზოლი, ინსტრუმენტთა 

პანელი, სტატუსის ანუ მდგომარეობის ზოლი, ვერტიკალური და ჰორიზონტალური 

გადაფურცვლის ველები და სამუშაო არე (ამ ელემენტების აღწერა იხილეთ Microsoft 

Word-ის გარემოს ზოგად მიმოხილვაში). 

Microsoft PowerPoint-ის ფანჯრის ცენტრალური ნაწილი შედგება სამი სხვადასხვა 

დანიშნულების არისაგან:  

1. Slide Pane - სლაიდის არე;  

2. Outline Pane - სტრუქტურის არე;  

3. Notes Pane - შენიშვნის არე.  
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სლაიდის არეში შესაძლებელია პრეზენტაციის ცალკეულ სლაიდზე მუშაობა: 

ტექსტის შეყვანა და რედაქტირება, გრაფიკული და სხვა ობიექტების განთავსება, 

ანიმაციური ეფექტების განსაზღვრა და სლაიდის ცალკეული ელემენტების 

ფორმატირება. სტრუქტურის არეს აქვს ორი რეჟიმი:  

1. Normal (Slides Tab სლაიდების ჩანართი), სადაც შემცირებული მასშტაბით 

აისახება პრეზენტაციის ყველა სლაიდის თანამიმდევრობა, რაც აადვილებს ისეთი 

ოპერაციების შესრულბას, როგორიცაა საჭირო სლაიდის მოძებნა და გააქტიურება, 

სლაიდის გადაადგილება, წაშლა და სხვა - გამოიძახება ღილაკით View→Normal.  

2. Outline View (Outline Tab სტრუქტურის ჩანართი), სადაც აისახება პრეზენტაციის 

თითოეული სლაიდის მხოლოდ ტექსტური შიგთავსი (ყველა დონის სათაურები და 

ძირითადი ტექსტი) - გამოიძახება ღილაკით View→Outline View.  

შენიშვნების არეში შესაძლებელია თითოეულ სლაიდთან დაკავშირებული 

დამატებითი ინფორმაციის შეყვანა. ეს ინფორმაცია შეიძლება გამოიყენოს 

მომხსენებელმა პრეზენტაციის დემონსტრაციის დროს.  

ახალი საპრეზენტაციო დოკუმენტის შექმნა შესაძლებელია სხვადასხვა რეჟიმების 

გამოყენებით. File→New ბრძანების გააქტიურებით ეკრანზე, სამუშაო არის მარჯვნივ, 

გამოდის New Presentation ფანჯარა, საიდანაც შეგვიძლია ავირჩიოთ პრეზენტაციის 

შექმნის რეჟიმი:  

- Blank document - ცარიელი საპრეზენტაციო დოკუმენტის შექმნა. ამ რეჟიმის 

არჩევისას მომხმარებელი თვითონ განსაზღვრავს პრეზენტაციის სტრუქტურას, 

დიზაინს, ობიექტების განლაგებას და ა.შ.  

- From Design Template - დიზაინის მზა შაბლონზე დაფუძნებული საპრეზენტაციო 

დოკუმენტის შექმნა.  

ტექსტის ფორმატირება/რედაქტირებისათვის გამოიყენება Microsoft Office-ის 

სტანდარტული საშუალებები, რომელიც განხილულია Microsoft Word-ის 

შესაძლებლობების აღწერისას. 

პრეზენდაციაში სლაიდის დამატება შესაძლებელია მოცემული ბრძანებებიდან 

ერთ-ერთის გამოყენებით:  

• Slides Tab ჩანართის კონტექსტური მენიუდან  New Slide ბრძანების 

გააქტიურებით;  

• Home →New Slide ღილაკის გააქტიურებით;  

• Ctrl და M კლავიშთა კომბინაციით. ახალი სლაიდის დამატება ხდება აქტიური 

სლაიდის შემდეგ და აქვს წინასწარ განსაზღვრული სტრუქტურა (სათაურისა და 

ძირითადი ტექსტის არეები), რომლის შეცვლა შესაძლებელია მომხმარებლის 

სურვილისამებრ. 

სლაიდის გადაადგილება შესაძლებელია სტრუქტურის არის Slides Tab 

სლაიდების ჩანართიდან. მოვნიშნოთ შესაბამისი სლაიდი და მაუსზე ხელაუღებლივ 

გადავიტანოთ სასურველ პოზიციამდე.  

სლაიდის დუბლირება გვჭირდება მაშინ, როცა არსებული სლაიდის საფუძველზე 

ვაპირებთ ახალი სლაიდის შექმნას. სლაიდის დუბლირება შესაძლებელია მოცემული 

ბრძანებებიდან ერთ-ერთის გამოყენებით: 

- სტრუქტურის არის Slides Tab სლაიდების ჩანართიდან მოვნიშნოთ შესაბამისი 

სლაიდი და კონტექსტური მენიუდან  გავააქტიუროთ Duplicate→Slide ბრძანება;  



22 
 

- სტრუქტურის არის Slides Tab სლაიდების ჩანართიდან მოვნიშნოთ შესაბამისი 

სლაიდი, დავაკოპიროთ იგი Ctrl და C კლავიშთა კომბინაციით და მერე Ctrl და V 

კლავიშთა კომბინაციით ჩავსვათ სასურველ ადგილას; 

- Ctrl და D კლავიშთა კომბინაციით.  

სლაიდის წაშლა შესაძლებელია მოცემული ბრძანებებიდან ერთ-ერთის 

გამოყენებით:  

- სტრუქტურის არის Slides Tab სლაიდების ჩანართიდან მოვნიშნოთ შესაბამისი 

სლაიდი და გავააქტიუროთ Delete კლავიში;  

- სტრუქტურის არის Slides Tab სლაიდების ჩანართიდან მოვნიშნოთ შესაბამისი 

სლაიდი და კონტექსტური მენიუდან გავააქტიუროთ Delete Slide ბრძანება. 

სლაიდის მაკეტის არჩევა. პრეზენტაციის შექმნისა და ახალი სლაიდის 

დამატებისას თავდაპირველად სლაიდებს აქვს წინასწარ განსაზღვრული სტრუქტურა 

(სათაურისა და ძირითადი ტექსტის არეები), რომლის შეცვლა შესაძლებელია 

მომხმარებლის სურვილისამებრ. PowerPoint-ი გვთავაზობს სლაიდების მაკეტების მზა 

შაბლონების კოლექციას, რომელთა საფუძველზეც შეგვიძლია სლაიდის სტრუქტურის 

განსაზღვრა. ახალი სლაიდის შექმნისას Home→New Slide ბრძანებით გამოვა Layout 

პანელი, სადაც მოცემულია მაკეტების მზა შაბლონების კოლექცია. მზა შაბლონების 

კოლექციიდან სასურველი მაკეტის არჩევა ხდება მაუსის დაწკაპუნებით შესაბამის 

მაკეტზე. სლაიდის მაკეტის არჩევის შემდეგ, ხდება სლაიდზე ტექსტისა და ობიექტების 

განთავსება. საჭიროების შემთხვევაში შესაძლებელია სლაიდის სტრუქტურის შეცვლა 

Home→Layout ბრძანებით და დამატებითი ობიექტებისა და ტექსტური არეების დამატება. 

სლაიდის გაფორმება დიზაინის შაბლონის გამოყენებით 

გარდა სლაიდების ფონებით გაფორმებისა, PowerPoint-ი პრეზენტაციის დიზაინის 

მზა შაბლონებით გაფორმების საშუალებას იძლება. სლაიდის დიზაინის განსაზღვრა 

შესაძლებელია მთავარი მენიუს Design ჩანართის Themes პანელიდან, სადაც მოცემულია 

სლაიდის გაფორმების დიზაინის მზა შაბლონების კოლექცია. შაბლონის ასარჩევად 

დავაყენოთ მაუსი სასურველი დიზაინის შაბლონზე და გავხსნათ კონტექსტური მენიუ.  

Apply to All Slides - ბრძანება უზრუნველყოფს არჩეული დიზაინის გამოყენებას 

პრეზენტაციაში შემავალი ყველა სლაიდისთვის.  

Apply to Selected Slides - ბრძანება უზრუნველყოფს არჩეული დიზაინის 

გამოყენებას მხოლოდ მონიშნული სლაიდებისთვის. 

სლაიდის ანიმაციები 

პრეზენტაციის გაფორმების მიზნით შესაძლებელია გამოვიყენოთ სლაიდის 

ანიმაციური ეფექტები. სლაიდის ანიმაციური ეფექტების განსაზღვრა შესაძლებელია 

მთავარი მენიუს Transition ჩანართიდან. მოვნიშნოთ შესაბამისი სლაიდი და გადავიდეთ 

Transition პანელზე, სადაც Transition to This Slide სექციაში მოცემულია სლაიდის 

ანიმაციური ეფექტების ვარიანტები. ამავე პანელში განისაზღვრება ანიმაციის შემდეგი 

ეფექტები: 

• Duration ანიმაციის შესრულების ხანგრძლივობის განსაზღვრა; 

• Sound ანიმაციაზე ხმოვანი ეფექტის დამატება; 

• On Mouse Click ანიმაციის გააქტიურება მაუსის დაწკაპუნების შემდეგ;  

• After პრეზენტაციის ჩვენებისას ავტომატურად მითითებული დროის შემდეგ;  
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• Apply to All საბრძანებო ღილაკი უზრუნველყოფს არჩეული ანიმაციური 

ეფექტის გამოყენებას ყველა სლაიდისთვის. 

ობიექტების ანიმაციური ეფექტები 

პრეზენტაციის გაფორმების მიზნით სლაიდის ანიმაციური ეფექტების გარდა 

შესაძლებელია გამოვიყენოთ ცალკეული ობიექტების ანიმაციური ეფექტები. 

მოვნიშნოთ შესაბამისი ობიექტი (ტექსტი, სურათი და ა.შ.) და გადავიდეთ 

მთავარი მენიუს Animations ჩანართში, სადაც Animation პანელში ავირჩიოთ ანიმაციური 

ეფექტი. 

 

პრაქტიკული სამუშაოები: PowerPoint-ში მოცემულ თემაზე პრეზენტაციის 

მომზადება სხვადასხვა ანიმაციური ეფექტების გამოყენებით. 
 

თემა 9. ელექტრონული ცხრილების პროგრამა MS Excel 

MS Excel-ის ამუშავება, ძირითადი ფანჯრის აღწერა. პროგრამა Excel, რომელიც 

შედის MS Office-ის შემადგენლობაში, საშუალებას იძლევა შევქმნათ საბუთების 

ბლანკები, ჩავატაროთ გამოთვლები ფორმულების საშუალებით, ვაწარმოოთ 

სამუშაოები, რომლებიც მოითხოვენ ინფორმაციის მოწესრიგებას და სისტემატიზაციას. 

Excel-ის ჩატვირთვა. დავაჭიროთ Start→All apps→Microsoft Office→MS Excel ან 

სამუშაო მაგიდაზე ორჯერ დავაჭიროთ თაგვის მარცხენა ღილაკი MS Excel პიქტოგრამას. 

აღნიშნული მოქმედებებიდან ერთ-ერთის შესრულების შედეგად მიიღება ახალი ფაილი, 

რომელსაც სამუშაო წიგნი (Book) ეწოდება. ახალ სამუშაო წიგნს ავტომატურად ენიჭება 

სახელი Book1, Book2,..., თუმცა შესაძლებელია ამ სახელის შეცვლა. სამუშაო წიგნი თავის 

მხრივ შედგება სამუშაო ფურცლებისაგან (Sheet1, Sheet2,...).  

MS Excel-ის მთავარი ფანჯრის სტრუქტურა. MS Excel-ის ძირითადი ფანჯარა 

შედგება შემდეგი ელემენტებისაგან: სათაურის სტრიქონი, მენიუს ზოლი, მენიუს ლენტა 

(Ribbon), სწრაფად ჩასართავი ღილაკთა პანელი (Quick Access Toolbar), უჯრედის სახელის 

ველი, ფორმულის სტრიქონი (fx), სამუშაო ფურცელი, წიგნის ფურცლების ზოლი, 

ფურცლის ხედი (ნორმალური, მაკეტური გვერდი ან გვერდი გამყოფით), 

ჰორიზონტალური და ვერტიკალური გადამხვევები, ზომის მარეგულერებელი, 

სტატუსის სტრიქონი. 

ყოველ სამუშაო ფურცელზე ასახულია ბადე, მისი სვეტები მონიშნულია 

ინგლისური ანბანის ასოებით  A, B, C,......, Z, AA, AB.... ხოლო სტრიქონები 

გადანომრილია.  სტრიქონების რიცხვია 1048576. სვეტების მონიშვნა იწყება A-დან Z-მდე; 

გრძელდება AA-დან AZ-მდე; შემდეგ BA-დან BZ-მდე და ა. შ. 16384 სვეტამდე.  

სვეტისა და სტრიქონის გადაკვეთით შექმნილ მართკუთხედს უჯრედი ეწოდება, 

მას გააჩნია მისამართი, შემდგარი შესაბამისი სვეტისა და სტრიქონის სახელებისაგან, მაგ; 

A1, B5, ...... უჯრედს რომელშიც ამჟამად ვმუშაობთ, აქტიური ეწოდება, ის მოთავსებულია 

ჩარჩოში.  

უჯრედის მისამართი უნიკალურია. მაგალითად, B4 უჯრედი მდებარეობს B 

სვეტისა მე-4 სტრიქონის გადაკვეთაზე. ექსელის ფურცელზე მითითებულია უჯრედის 

სახელი (Name box) არეში. ეს იმაზე მიანიშნებს, რომ, ამჟამად აქტიურია B4 უჯრედი. 

მისამართში ჯერ იწერება სვეტის აღმნიშვნელი ასო, ხოლო შემდეგ სტრიქონის ნომერი. 

აქტიური უჯრედის შიგთავსი ყოველთვის მოსჩანს (მოთავსებულია) ფორმულის არეში. 
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სვეტის სიგანის შესაცვლელად: კურსორი დააყენეთ სვეტის ზემოთ, სვეტის 

დასათაურების მარჯვენა მხარეს - გამოჩნდება ორმხრივი ისარი; დააჭირეთ მაუსის 

მარცხენა ღილაკი და მაუსი გააცურეთ მარჯვნივ სვეტის სიგანის გასადიდებლად, ხოლო 

მარცხნივ სვეტის სიგანის შესამცირებლად. როდესაც მიაღწევთ სასურველ ზომას მაუსს 

აუშვით. 

სტრიქონის სიმაღლის შესაცვლელად: კურსორი დააყენეთ იმ სტრიქონის ნომრის 

ქვემოთ, რომლის მოდიფიცირება გსურთ - გამოჩნდება ორმხრივი ისარი; დააჭირეთ 

მაუსის მარცხენა ღილაკი და მაუსი გააცურეთ ზემოთ სტრიქონის სიმაღლის 

შესამცირებლად ან ქვემოთ, როცა საჭიროა სტრიქონის სიმაღლის გაზრდა. როდესაც 

მიაღწევთ სასურველ ზომას მაუსს აუშვით. 

სვეტის ჩასამატებლად: ამოირჩიეთ სვეტი, რომლის მარცხნივ გვინდა ჩავსვათ 

ახალი სვეტი. Home-ის Cells ჯგუფიდან ჩამოშალეთ Insert ღილაკის ქვემენიუ და აირჩიეთ 

ბრზანება Insert Sheet Columns - ჩამატებული სვეტი გამოჩნდება. ან კონტექსტური 

მენიუდან აირჩიეთ ბრძანება Insert და მერე დიალოგური ფანჯრიდან აირჩიეთ Entire 

Column → OK. 

სტრიქონის ჩასამატებლად: ამოირჩიეთ სტრიქონი, რომლის ზემოთ აპირებთ 

ახალი სტრიქონის ჩასმას. Home-ის Cells ჯგუფიდან ჩამოშალეთ Insert ღილაკის ქვემენიუ 

და აირჩიეთ ბრძანება Insert Sheet Rows - ჩამატებული სვეტი გამოჩნდება. ან კონტექსტური 

მენიუდან აირჩიეთ ბრძანება Insert და მერე დიალოგური ფანჯრიდან აირჩიეთ Entire Row 

→ OK. 

უჯრედებზე ჩარჩოების შემოვლება: 

1.) ის უჯრედები მონიშნეთ, რომლისთვისაც ჩარჩოს დამატება გინდათ.  

2.) იპოვეთ ინსტრუმენტი Borders (ჩარჩოების დამატება). Borders-ის გვერდით 

ისარზე დააწკაპუნეთ.  

3.) კვადრატთა ჯგუფები ელექტრონული ცხრილის უჯრედებს წარმოადგენს, 

მსხვილი ხაზები კი - ჩარჩოებს. მოსინჯეთ ზოგი ჩარჩო, რომელიმე მათგანზე 

დაწკაპუნებით.  

რიცხვებისა და თარიღის ფორმატირება. 

• აირჩიეთ უჯრედი ან უჯრედები, რომელთა შიგთავსის ფორმატირება გსურთ; 

• Home-ის Numbers ჯგუფიდან ჩამოშალეთ Number Format - ის ამოსარჩევი სია: 

სტანდარტულად საწყის ეტაპზე რიცხვები წარმოდგენილი არიან კატეგორიით General 

(ზოგადი), რაც იმას ნიშნავს, რომ სპეციალური ფორმატირების ელემენტები 

გამოყენებული არ არის. წარმოდგენილი სიიდან ვირჩევთ რიცხვთა სასურველ ფორმატს. 

შეიძლება რიცხვები გამოისახონ პროცენტული სახით, დავუმატოთ მძიმით გამოყოფა და 

სხვა. 

Numbers ჯგუფში აგრეთვე წარმოდგენილია ფორმატირების რამდენიმე სხვა 

საშუალება:  

1. Accounting Number Format - ვალუტის სტილი, სადაც ხდება ვალუტის ამორჩევა; 

2. Percent Style - სიდიდის პროცენტული გამოსახვა; 

3. Comma Style - სტილი ათასობითი ნაწილის გამოყოფით;  

4. Increase Decimal, Decrease Decimal - წილადი ნაწილის რეგულირება. 

უჯრედის მნიშვნელობის წაშლა. უჯრედის (ან უჯრედთა დიაპაზონის) 

მნიშვნელობის წასაშლელად საჭიროა მათი მონიშვნა და Delete კლავიშზე დაჭერა. წაშლა 
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შესაძლებელია ასევე ლენტის Home ჩანართის Editing ბრძანებათა ჯგუფში Clear ღილაკის 

გამოყენებით. გახსნილ მენიუში შეარჩიეთ შესაბამისი ბრძანება წასაშლელად: 

• ფორმატების წაშლა (Clear Formats - ფორმატების გასუფთავება), 

• შინაარსის (Clear Contents - შინაარსის გასუფთავება), 

• კომენტარების (Clear Comments - კომენტარების წაშლა) 

• ყველაფრის, რაც არის უჯრედში (Clear All - ყველაფრის გასუფთავება) . 

ფორმატებისა და შენიშვნების გასუფთავების შემდეგ უჯრედში მონაცემები არ შეინახება. 

 

პრაქტიკული სამუშაოები: Excel-ში დიდი ცხრილის მონაცემების სტატისტიკური 

ანალიზი პირობითი ფუნქციების საშუალებით; ეკონომიკურ უწყისებში პირობითი 

ფუნქციების გამოყენება. 
 

თემა 10. ფორმულები და ფუნქციები 

ფორმულები. ფორმულის ჩაწერა იწყება “ = “ სიმბოლოთი. ფორმულების 

ჩასაწერად გამოიყენება რიცხვები, უჯრედთა მისამართები, უჯრედთა დიაპაზონები, 

მათემატიკური ოპერაციის ნიშნები, ფრჩხილები და ფუნქციათა დასახელებები. 

არითმეტიკული ოპერაციებია: + - შეკრება; – - გამოკლება; * - გამრავლება; / - გაყოფა; ^ - 

ახარისხება; % - პროცენტად გარდაქმნა. <, >, <>, <=, >=, = - შედარების ოპერაციებია. “ & “ 

- ტექსტური ოპერაციის აღმნიშვნელი სიმბოლოა. იგი აერთიანებს ოპერანდების 

სიმბოლოთა მიმდევრობას ერთ მიმდევრობად. ოპერაციათა შესრულების პრიორიტეტი 

შემდეგია: %, ^, * და /, + და –, & და ბოლოს შედარების ოპერაციები. პირველ რიგში 

სრულდება მრგვალ ფრჩხილებში მოთავსებული გამოსახულებები; ერთნაირი 

პრიორიტეტის მქონე ოპერაციები სრულდება მიმდევრობით - მარცხნიდან მარჯვნივ. 

ფორმულების შეტანა და შედეგების გამოთვლა. მოვნიშნოთ უჯრედი, რომელშიც 

უნდა მოთავსდეს ფორმულით გამოთვლის შედეგი; ავკრიბოთ სიმბოლო “ = “ და 

დავიწყოთ ფორმულის ტექსტის შეტანა. ფორმულის ტექსტი აისახება ფორმულათა 

სტრიქონში, სადაც საჭიროების შემთხვევაში შესაძლებელია მისი რედაქტირება; 

დავასრულოთ ფორმულის შეტანა <Enter> კლავიშზე ხელის დაჭერით ან ფორმულათა 

სტრიქონში   ღილაკზე მაუსის დაწკაპუნებით. უჯრედში გაჩნდება ფორმულით 

გამოთვლის შედეგი. 

მიმართვა. ფორმულის ჩაწერისას მასში გამოიყენება რომელიმე უჯრედის ან 

უჯრედთა დიაპაზონის მისამართი, რის შემდეგაც ფორმულის გამოთვლის შედეგი 

დამოკიდებული იქნება მათ შემცველობაზე. მიმართვების დახმარებით ფორმულებში 

შეიძლება გამოვიყენოთ ფურცლის სხვადასხვა ადგილზე განთავსებული მონაცემები, 

დავთარში შემავალი სხვადასხვა ფურცლის მონაცემები და სხვადასხვა დავთრების 

მონაცემები, მაგალითად: 

მიმართვა. მიმართვის დიაპაზონი. 

• B2 - მიმართვა აქტიური ფურცლის B2 უჯრედზე; 

• A5:C8 - მიმართვა A5-დან C8-მდე დიაპაზონის უჯრედებზე; 

• 3:3 - მიმართვა მესამე სტრიქონის ყველა უჯრედზე; 

• 4:8 - მიმართვა მეოთხედან მერვე სტრიქონის ჩათვლით ყველა უჯრედზე; 

• D:D - მიმართვა D სვეტის ყველა უჯრედზე; 

• Sheet2!B2 - მიმართვა Sheet2 ფურცლის B2 უჯრედზე; 

• Sheet2!A1:C5 - მიმართვა Sheet2 ფურცლის A1:C5 დიაპაზონზე; 
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• Sheet1:Sheet3!D2 - მიმართვა Sheet1, Sheet2, Sheet3 ფურცლების D2 უჯრედებზე; 

• [Book2]Sheet1!$A$5 - მიმართვა Book2 დავთრის Sheet1 ფურცლის A5 

უჯრედზე. 

დიაპაზონებზე მიმართვის დროს იყენებენ შემდეგ ოპერატორებს: 

: (ორწერტილი) გამოიყენება დიაპაზონის უკიდურესად მარცხენა მხარის 

უჯრედის მისამართსა და მარჯვენა მხარეს არსებულ უჯრედის მისამართს შორის. ასეთი 

შეთანხმება არის სტანდარტული მისამართი უჯრედთა დიაპაზონზე (მაგალითად, 

=Sum(B2:B6) იგივეა, რაც =Sum(B2, B3, B4, B5, B6)). 

; (წერტილმძიმე) დიაპაზონების გაერთიანების ოპერატორი. აერთიანებს 

რამდენიმე დიაპზონს ერთში (მაგალითად, ორი დიაპაზონის გასაერთიანებლად 

შეიძლება ჩაიწეროს: Sum(B5:B15;D5:D15). 

  (გამოტოვება - space) გადაკვეთის ოპერატორი, გამოიყენება ორი დიაპაზონის 

საერთო უჯრედებზე მისათითებლად (მაგალითად, (B7:D7 C6:C8)). 

ფარდობითი მისამართი. ფორმულის შეტანის დროს მისამართის აკრეფვა 

შეიძლება როგორც კლავიატურიდან, ასევე მაუსის შესაბამის უჯრედზე დაწკაპუნებით. 

ამ დროს ფორმულაში, იქ სადაც კურსორი ციმციმებდა, ჩაიწერება ფარდობითი 

მისამართი. 

ფორმულების კოპირებისა და გადანაცვლების გამარტივების მიზნით Excel-ში 

შემოტანილია ე. წ. ფარდობითი მისამართის ცნება. მონაცემის ფარდობითი მისამართის 

ქვეშ იგულისხმება არა მიმართვა მათ მუდმივ ადგილმდებარეობაზე, არამედ მიმართვა 

მათ ფარდობით ადგილმდებარეობაზე. ფარდობითი მისამართის მომდევნო უჯრედებში 

გავრცელების, კოპირების, ჩამატების ან წაშლის დროს მისამართი იცვლება და ფორმულა 

იმეორებს ფორმულის შემცველი უჯრედიდან მიმართვის უჯრედამდე მოძრაობის 

მარშრუტს. 

აბსოლუტური მისამართი. თუ ფორმულის ჩაწერის დროს ყოველთვის უნდა 

მივმართოთ ერთი და იმავე უჯრედს, მაშინ ეს მიმართვა ფორმულის მომდევნო 

უჯრედებში გავრცელების ან კოპირების დროს არ უნდა შეიცვალოს. ამ დროს უნდა 

გამოვიყენოთ უჯრედის აბსოლუტური მისამართი. აბსოლუტური მისამართის 

მისათითებლად სტრიქონისა და სვეტის დასახელებათა წინ საჭიროა დოლარის ნიშნის 

მითითება ან უჯრედს შეიძლება დავარქვათ სახელი Formulas მენიუს Defined Names 

ქვემენიუს Define Name ბრძანებით, შემდეგ კი გამოვიყენოთ გამოთვლების დროს, 

როგორც აბსოლუტური მისამართი. 

იმისათვის, რომ ფორმულაში შევიტანოთ უჯრედის აბსოლუტური მისამართი, 

საჭიროა: 

მოვნიშნოთ უჯრედი, რომელშიც უნდა მოთავსდეს ფორმულით გამოთვლის 

შედეგი და ავკრიფოთ “ = “ სიმბოლო; 

დავაწკაპუნოთ მაუსი უჯრედზე, რომლის აბსოლუტური მისამართის ჩაწერაც 

გვსურს აღნიშნულ ფორმულაში; 

დავაჭიროთ ხელი <F4> კლავიშს, უჯრედის მისამართის სტრიქონისა და სვეტის 

დასახელებათა წინ გაჩნდება დოლარის ნიშანი. ნიშანი “ $ “ შეიძლება შევიტანოთ 

ხელითაც; 
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<F4> კლავიშზე ხელის განმეორებითი დაჭერა გამოიწვევს მისამართების ტიპების 

რიგრიგობით შეცვლას. მაგალითად, <F4> კლავიშზე ხელის განმეორებითი დაჭერის 

შემდეგ მივიღებთ $A$1, A$1, $A1, A1 ტიპის მისამართებს. 

მაგალითად: 

$A1 - მუდმივად მიმართავს A სვეტს, ხოლო სტრიქონთან მიმართვა შეიძლება 

შეიცვალოს; 

A$1 - მუდმივად მიმართავს პირველ სტრიქონს, ხოლო სვეტთან მიმართვა 

შეიძლება შეიცვალოს; 

$A$1 - ყოველთვის მიმართავს A1 უჯრედს. 

A1 ტიპის მიმართვებს ეწოდებათ ფარდობითი, $A$1 - აბსოლუტური, ხოლო $A1 

ან A$1 - შერეული. 

ფუნქციები. გამოთვლების გასაადვილებლად Excel-ს აქვს მზა ფუნქციების 

საკმაოდ დიდი რაოდენობა, სადაც ნებისმიერი ფუნქცია წინასწარ შექმნილი ფორმულაა, 

რომელიც გარკვეულ ოპერაციებს ასრულებს. ისინი საშუალებას გვაძლევენ სწრაფად და 

ადვილად შევასრულოთ რთული გამოთვლები. ფუნქციები გამოიყენება მათემატიკური, 

ეკონომიკური და ინჟინრული გამოთვლებისთვის, ლოგიკური მოქმედებების 

შესასრულებლად. 

გამოთვლებისთვის საჭირო საწყისი მონაცემები არგუმენტების სახით ჩაიწერება 

მრგვალ ფრჩხილებში ფუნქციის სახელის შემდეგ (არგუმენტები ერთმანეთისგან მძიმით 

გამოიყოფა). 

არგუმენტის სახით შეიძლება მიეთითოს რიცხობრივი ან ტექსტური 

მნიშვნელობები, უჯრედების მისამართები, დიაპაზონების მისამართები ან სახელები. 

ზოგიერთი ფორმულა შეიძლება შედგებოდეს მხოლოდ ერთი ფუნქციისგან, სხვებში 

შეიძლება იყოს რამდენიმე ფუნქცია. 

მაგალითად, ფუნქცია არგუმენტებით: =Sum(A6:A16) აბრუნებს უჯრედებში A6-

დან A16-მდე არსებული მნიშვნელობების ჯამს.  

Excel-ის ხშირად გამოყენებადი ფუნქციები: 

SUM - ითვლის მითითებულის დიაპაზონის რიცხვითი მნიშვნელობების ჯამს; 

AVERAGE - ითვლის საშუალო არითმეტიკულს; 

COUNT - ითვლის რიცხვითი მონაცემებით შევსებულ მონიშნულ უჯრედითა 

რაოდენობას; 

MAX - პოულობს მაქსიმალურ მნიშვნელობას მითითებულ დიაპაზონში; 

MIN - პოულობს მინიმალურ მნიშვნელობას მითითებულ დიაპაზონში. 

ამ ფუნქციების გამოძახება შესაძლებელია ლენტის Home ჩანართის Editing 

ბრძანებათა ჯგუფის AutoSum მართვის ღილაკის ქვემენიუდან. 

შევსების მარკერის (Fill Handle) გამოყენება. განვიხილოთ ექსელის ერთი 

მნიშვნელოვანი მახასიათებელი საშუალება - გაავრცელოს მსგავსი გათვლები მთელ 

საანგარიშო სივრცეზე. 

მაგალითად, E2 უჯრედში ნაანგარიშები C2 და D2 უჯრედებში ჩაწერილი 

რიცხვების ნამრავლის მსგავსად გვინდა მივიღოთ მონაცემები E3:E5 დიაპაზონზე. 

ამისათვის ვიქცევით შემდეგნაირად: მივიყვანოთ მაუსის კურსორი E2 უჯრედის 

მარჯვენა ქვედა კუთხეში შევსების მარკერთან - კურსორის ფორმა შეიცვლება, 

დავაჭიროთ მაუსის მარცხენა ღილაკი და თითის აუშვებლად ჩამოვაცუროთ მაუსი. 
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მისამართების ე.წ. შეფარდებითი ცვლილებები ჩანს ფორმულის პანელზე: 

E3=С3*D3,  E4=С4*D4, E5=С5*D5 ე. ი. გამოსახულებაში ოპერანდები იცვლებიან ყოველ 

შემდგომ პოზიციაზე. 

ფორმულებსა და ფუნქციებთან მუშაობის ზოგადი წესები.  

1. ფორმულის ჩაწერა იწყება ტოლობის ნიშნით;  

2. ფორმულა შეიძლება შეიცავდეს ერთ ან რამოდენიმე ფუნქციას;  

3. ფუნქციის დასახელების შემდეგ მრგვალ ფრჩხილებში იწერება მისი 

არგუმენტების სია, რომლებიც ერთმანეთისაგან მძიმით ან წერტილ-მძიმით გამოიყოფა;  

4. თუ ფუნქცია არგუმენტებს არ შეიცავს, მრგვალი ფრჩხილები მაინც საჭიროა;  

5. ფუნქციას არ შეიძლება ჰქონდეს 30-ზე მეტი არგუმენტი;  

6. არგუმენტად ჩაწერილი დიაპაზონი ითვლება ერთ არგუმენტად;  

7. ფორმულის სიგრძე არ უნდა აჭარბებდეს 1024 სიმბოლოს. 

შეტყობინებები შეცდომათა შესახებ. ფორმულის არასწორად ჩაწერის შემთხვევაში 

Excel-ი გვაძლევს შემდეგი ტიპის შეტყობინებებს: 

- #### - ფორმულის მიერ მიღებული გამოთვლის შედეგი არ ეტევა უჯრედში. 

საჭიროა ამ უჯრედის შესაბამისი სვეტის სიგანის გაფართოება; 

- #DIV/0! - ფორმულის რეალიზაციის პროცესში გვხვდება ნულზე გაყოფა; 

- #NAME? - ფორმულაში გამოყენებული სახელი არ არის დავთრის სახელების 

სიაში ან ტექსტური ცვლადი არ არის ჩასმული ბრჭყალებში; 

- #VALUE! - მათემატიკური ფორმულა მიმართავს ტექსტურ ცვლადს; 

 

პრაქტიკული სამუშაოები: Excel-ში გამოთვლების შესრულება ფორმულების 

საშუალებით; AutoSum ღილაკის ფუნქციების გამოყენება; მაგალითები შევსების 

მარკერის გამოყენებაზე. 
 

თემა 11. Excel-ის Insert მენიუს ბრძანებები. MS Excel-ში დიაგრამებთან მუშაობა 

ცხრილებისა და დიაგრამების გასაფორმებლად Excel-ში არსებობს უამრავი 

საინტერესო საშუალებანი. ისინი თავმოყრილია Insert მენიუს Illustrations, Text და Symbols 

ქვემენიუებში შესაბამისი ღილაკების სახით. 

უნდა აღვნიშნოთ, რომ მსგავსი ღილაკები აგრეთვე არის MS Word-ის Insert მენიუში 

- მათი ფუნქციები ჩვენ უკვე განვიხილეთ MS Word-ის შესწავლის დროს. ამიტომ ჯობია 

პირდაპირ გადავიდეთ Excel-ის დიაგრამების აგების საშუალებებზე, რომლებიც 

წარმოდგენილია Insert მენიუს Charts, Maps და Sparklines ქვემენიუებში. 

დიაგრამის შექმნა. დიაგრამის შესაქმნელად გამოიყენება დიაგრამათა შექმნის 

სპეციალური ოსტატი, რომლის გამოძახება შეიძლება Insert მენიუს Charts ქვემენიუს 

სხვადასხვა ტიპის დიაგრამების შესაბამისი ღილაკებით ან Charts ქვემენიუში ისარზე 

მაუსის დაწკაპუნებით. გახსნილ Insert Chart დამატებით ფანჯარაში შესაძლებელია 

შესაბამისი ტიპის დიაგრამების შერჩევა. იმ შემთხვევაში თუ გამოსულ დიალოგურ 

ფანჯარაში წარმოდგენილი გრაფიკები არ გაწყობთ, შეგიძლიათ More Column Charts… 

ბრძანებაზე დაწკაპუნებით გადახვიდეთ დიალოგურ ფანჯარაში, სადაც მოცემული 

იქნება გრაფიკების სხვა ვარიანტები. აგრეთვე თქვენ შეგიძლიათ შეარჩიოთ გრაფიკის 

დიზაინი ამავე ფანჯრის Recommended Charts ჩანართიდან. 
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დიაგრამის ტიპის შერჩევა. Excel-ს 15 სხვადასხვა ტიპის დიაგრამა აქვს: Column, 

Line, Pie, Bar, Area, XY(Scatter), Stock, Surface, Radar, Treemap, Sunburst, Histogram, Box & 

Whisker, Waterfall, Combo. მათ შორის 5 არის ყველაზე გავრცელებული. ესენია: 

1. Column - სვეტისმაგვარი დიაგრამა, მასში შედის აგრეთვე ცილინდრული, 

კონუსური, პირამიდული ჰისტოგრამები; 

2. Line - გრაფიკი (წრფივი დიაგრამა); 

3. Pie - წრიული დიაგრამა (ნამცხვრისმაგვარი დიაგრამა, სადაც ჩანს თვითოეულის 

შეფარდება საერთოსთან); 

4. Bar - ხაზოვანი (პანელოვანი) დიაგრამა; 

5. XY(Scatter) - წერტილოვანი დიაგრამა (გაფანტული სახის დიაგრამა). 

დიაგრამის შექმნა. დიაგრამების აგება შემდეგი ზოგადი სქემით ხდება: გამოვყოთ 

ცხრილში ფრაგმენტის სახით გრაფიკულად დასამუშავებელი რიცხვითი მონაცემები. თუ 

დიაგრამა მთელი ცხრილისათვის აიგება და გვსურს მის გაფორმებაში გამოყენებულ 

იქნეს სვეტებისა და სტრიქონების დასახელებები, უნდა გამოვყოთ მთელი ცხრილი; 

ავირჩიოთ Insert მენიუს Charts ქვემენიუში ერთერთი ტიპის დიაგრამა და ჩამოშლილ 

ველში ამ ტიპის დიაგრამებს შორის ავარჩიოთ ჩვენთვის მისაღები სტილი ან Charts 

ქვემენიუში ისარზე მაუსის დაწკაპუნებით გავხსნათ Insert Chart დამატებით ფანჯარა და 

იქ შევარჩიოთ შესაბამისი ტიპისა და სტილის დიაგრამა. 

დიაგრამის დამატებითი მენიუები Design და Format. თუ დიაგრამის ნაჩვენები 

ფორმა გვაკმაყოფილებს, მაშინ მისი ცალკეული ელემენტის მოწყობა-რედაქტირება 

შესაძლებელია დამატებითი Chart Tools/Design და Chart Tools/Format მენიუების 

შესაბამისი ინსტრუმენტთა პანელების ქვემენიუების ღილაკების საშუალებით. 

დიაგრამაზე სათაურის გამოტანა. მონიშნეთ დიაგრამა, Design ჩანართზე 

გააქტიურეთ ბრძანება Add Chart Element→Chart Title, შეირჩიეთ დიაგრამის სათაურის 

ადგილმდებარეობა - დაასათაურეთ დიაგრამა. 

დიაგრამაზე წანაწერის (Legend) გამოტანა. მონიშნეთ დიაგრამა, Design ჩანართზე 

გააქტიურეთ ბრძანება Add Chart Element→Legend, შეირჩიეთ განლაგება. 

ღერძების დასათაურება. მონიშნეთ დიაგრამა, Design ჩანართზე გააქტიურეთ 

ბრძანება Add Chart Element→Axis Title, შეირჩიეთ ღერძი და დაასათაურეთ. 

დიაგრამის სტილის შეცვლა. მონიშნეთ დიაგრამა, Design ჩანართზე გააქტიურეთ 

Chart Styles ჯგუფიდან შეარჩიეთ სასურველი სტილი. 

დიაგრამის ტიპის შეცვლა. მონიშნეთ დიაგრამა, Design ჩანართზე გააქტიურეთ 

Change Chart Type დიაგრამის სასურველი სტილი. 

მინიდიაგრამა (Sparkline). მინიდიაგრამას ჰქვია უჯრედების ფონის სახით 

რეალიზებულ დიაგრამას, რომელიც შესაბამისი სტრიქონის ან სვეტის მონაცემების 

ცვლილების ტენდენციას ვიზუალურად ასახავს. 

მინიდიაგრამის ასაგებად დავსვათ კურსორი იმ უჯრედში, სადაც ვაპირებთ 

მინიდიაგრამის ჩასმას, მერე Insert მენიუს Sparklines ჩანართიდან შევარჩიოთ 

მინიდიაგრამის ტიპი (Line, Column ან Win/Loss). 

გამოვა დიალოგური ფანჯარა Create Sparklines, სადაც Data Range ველში უნდა 

შევიყვანოთ იმ უჯრედების დიაპაზონი, რომლის საფუძველზეც აიგება მინიდიაგრამა. 

დიაპაზონის შესაყვანად საკმარისია მაუსით მოვნიშნოთ შესაბამისი უჯრედები. 

დავაჭიროთ ღილაკს OK. 
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მინიდიაგრამა ჩაისმევა მონიშნულ უჯრედში. შემდეგ ეტაპზე შევსების მარკერის 

საშუალებით გავავრცელოთ დიაგრამის ჩასმის ოპერაცია უჯრედების დიაპაზონზე. 

 

პრაქტიკული სამუშაოები: Excel-ში სხვადასხვა ტიპის გრაფიკების აგება და მათი 

ელემენტების რედაქტირების საშუალებების შესწავლა; ფუნქციის გრაფიკის აგება; 

კომბინირებული გრაფიკების აგება. 

 

თემა 12. Excel-ის  Formulas მენიუს  ბრძანებები: Insert Function ბრძანება. ფუნქციათა 

ოსტატი. IF (თუ), SUMIF, COUNTIF და AVERAGEIF ფუნქციების განხილვა 

გამოთვლების გასაადვილებლად Excel-ს აქვს მზა ფუნქციების საკმაოდ დიდი 

რაოდენობა. მათ განეკუთვნება: ფინანსური, ლოგიკური, ტექსტური, თარიღისა და 

დროის, მათემატიკური და ტრიგონომეტრიული და სხვ. 

Formulas მენიუს  ბრძანებები. ფუნქციის შესატანად გამოიყენება მართვის 

ღილაკები ლენტის ჩანართ Formulas (ფორმულების) განყოფილებიდან - Function Library 

(ფუნქციების ბიბლიოთეკა). 

ფუნქციების გამოძახების მიზნით უნდა მივმართოთ Formulas მენიუს Function 

Library ქვემენიუს შესაბამის ღილაკებს თემატიკის მიხედვით ან მაუსი დავაწკაპუნოთ 

იმავე ქვემენიუს fx - Insert Function ღილაკზე ან ფორმულათა ზოლის fx ღილაზე ან 

ინსტრუენტთა პანელის Σ AutoSum ღილაკზე ან გამოვიყენოთ <Shift>+ <F3> კლავიშთა 

კომბინაცია. 

ფუნქციათა ოსტატის პირველი ფანჯრის გახსნის შემთხვევაში გამონათდება 

დიალოგი, რომლის Or select a category ველში შეგვიძლია ავირჩიოთ ფუნქციის თემატიკა, 

ხოლო Select a function ველში მისი დასახელება. თემატიკაში All გვაქვს ყველა ფუნქციის 

ჩამონათვალი, ხოლო Most Recently Used-ში ხშირად გამოყენებული ფუნქციათა 

ჩამონათვალი. შემდეგ ეტაპზე გადასასვლელად დავაწკაპუნოთ OK ღილაკზე ან ხელი 

დავაჭიროთ <Enter> კლავიშს. 

ეკრანზე გაიხსნება ფუნქციათა ოსტატის მეორე ფანჯარა. ეს ფანჯარა შეიცავს 

ყველა საჭირო ცნობას არჩეული ფუნქციის გამოყენების შესახებ. არგუმენტების 

მნიშვნელობების შეტანა ხდება ამ ფანჯრის ტექსტურ ველში როგორც კლავიატურით, 

ასევე სათანადო უჯრედზე მაუსის დაწკაპუნებით ან მაუსით უჯრედთა ჯგუფის 

მონიშვნით. თითოეულ არგუმენტს ცალკე ტექსტური ველი ეთმობა. იმ შემთხვევაში, 

როდესაც ფუნქციას ცვლადი რაოდენობის არგუმენტები აქვს, არგუმენტის შეტანასთან 

ერთად დიალოგური ფანჯარა იზრდება და ეკრანზე ჩნდება დამატებითი ტექსტური 

ველები. 

IF - (პირობითი ფუნქცია). პირობის ფუნქციას ფართო გამოყენება აქვს. იგი ორ 

შესაძლებელ (ალტერნატიულ) მნიშვნელობაზეა გათვლილი. 

ფუნქციის სინტაქსი: IF (პირობა, მნიშვნელობა1, მნიშვნელობა2). პირობა 

წარმოადგენს ლოგიკურ გამოსახულებას, რომელიც ან ჭეშმარიტია (true), ან მცდარი 

(false). თუ პირობა ჭეშმარიტია, მაშინ ფუნქციას ენიჭება მნიშვნელობა1, თუ მცდარია - 

მნიშვნელობა2. 

მაგალითად: A1 უჯრედში წერია რიცხვი 9. C1 უჯრედში ჩაწერილია ფორმულა 

=IF(A1>0, 1, 0). თუ შესრულდა პირობა A1>0, C1 უჯრედში ჩაიწერება 1. წინააღმდეგ 

შემთხვევაში ჩაიწერება - 0. ამ შემთხვევაში ფუნქციის გამოყენების შედეგად მიიღება 1. 
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SUMIF, COUNTIF და AVERAGEIF ფუნქციების განხილვა. პირობის ფუნქცია 

ხშირად გამოიყენება სხვა ფუნქციებთან კომბინაციაში, ამიტომ Excel-ს დამატებული აქვს 

ისეთი ფუნქციები როგორიცაა SUMIF, AVERAGEIF, COUNTIF. 

SUMIF გამოიყენება მონაცემებით შევსებული უჯრედების შესაჯამებლად 

გარკვეული პირობის გათვალისწინებით. 

მაგალითად, ფორმულა =SUMIF(C2:C45, "West", H2:H45) შეაჯამებს H2:H45 

დიაპაზონიდან იმ უჯრედების შიგთავსს, რომლებსაც C2:C45 დიაპაზონში შეესაბამება 

სიტყვა "West". 

AVERAGEIF გამოიყენება მონაცემებით შევსებული უჯრედების საშუალო  

არითმეტიკულის გამოსათვლელად გარკვეული პირობის გათვალისწინებით. 

COUNTIF გამოიყენება მონაცემებით შევსებული უჯრედების რაოდენობის 

დასათვლელად გარკვეული კრიტერიუმის გამოყენებით.  

მაგალითად, ფორმულა =COUNTIF(C2:C87, "West") დაითვლის C2:C87 

დიაპაზონში იმ უჯრედების რაოდენობას, სადაც წერია "West". 
 

პრაქტიკული სამუშაოები: მაგალითები პირობით ფუნქციაზე; ეკონომიკურ 

უწყისებში პირობითი ფუნქციების გამოყენება; Excel-ში დიდი ცხრილის მონაცემების 

სტატისტიკური ანალიზი პირობითი ფუნქციების საშუალებით. 
 

თემა 13. Excel-ის Page Layout მენიუს ბრძანებები. დინამიური ცხრილების (Pivot Table) 

გამოყენების პრინციპები 

გვერდის პარამეტრების შერჩევა. გვერდის პარამეტრები განსაზღვრავს საბეჭდი 

ფურცლის გარეგნულ სახეს. მათ შესაცვლელად გამოიყენება Page Layout მენიუს Page Setup 

ქვემენიუ. ამ ქვემენიუს ისარზე მაუსის დაწკაპუნებით გაიხსნება Page Setup დიალოგური 

ფანჯარა, რომელსაც აქვს ოთხი ჩანართი Page, Margins, Header/Footer, Sheet. 

Page დიალოგური ჩანართის Orientation განყოფილებაში შეირჩევა ფურცლის 

მიმართულება Portrait (პორტრეტის სტილი) და Landscape (პეიზაჟის სტილი). Scaling 

განყოფილების Adjust to ველში შეირჩევა ცხრილის მასშტაბი (10%-400%). Fit to 

გადამრთველის ჩართვით შეიძლება მივუთითოთ რამდენ ფურცელზე გვსურს დიდი 

ცხრილის განთავსება. ამისათვის Page(s) wide by ველში მივუთითოთ სიგანეში, ხოლო tall 

ველში სიგრძეში ფურცლების რაოდენობა. Paper size ველში შეირჩევა ფურცლის ზომები. 

A4 ზომა შეესაბამება სტანდარტულ თაბახის ფურცელს. Print quality ველში 

განისაზღვრება ბეჭდვის ხარისხი (წერტილების რაოდენობა კვადრატულ დიუმზე). 

Margins დიალოგური ჩანართის ველებში შეირჩევა გვერდის მინდვრები Top - 

ზედა, Bottom - ქვედა, Left - მარცხენა, Right - მარჯვენა. Center on page ველში შესაბამისი 

ალმების ჩართვით შეირჩევა ქაღალდის ფურცელზე ცხრილის ცენტრირების წესი: 

ჰორიზონტალური (Horizontally) და/ან ვერტიკალური (Vertically). 

Header/Footer დიალოგურ ჩანართში შეიძლება გავაფორმოთ როგორც 

სტანდარტული, ასევე ნებისმიერი სახის (Custom Header, Custom Footer ღილაკზე 

დაჭერით) ზედა ან ქვედა კოლონტიტული. მათი ტექსტის დაცილება ფურცლის 

კიდეებიდან შეირჩევა Margins ჩანართის დიალოგის Header და Footer ველებში. 

Sheet ჩანართის Print area ველში შეიძლება მივუთითოთ დასაბეჭდი უჯრედების 

დიაპაზონი. Print titles ჯგუფში ორი ველია: Rows to repeat at top ემსახურება ყველა 

გვერდზე სვეტების სათაურების, ხოლო Columns to repeat at left სტრიქონების სათაურების 
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გამეორებას. გამეორება ასე ხდება: მოვნიშნოთ მაუსით ნებისმიერი უჯრედი იმ 

სტრიქონში, სადაც სვეტების სათაურებია ან სვეტში, სადაც სტრიქონების სათაურებია და 

დავაჭიროთ OK ღილაკს. თუ ამ ჩანართის Print ველში ალმით მოვნიშნავთ Gridline-ს 

დაიბეჭდება ცხრილის ბადეც, წინააღმდეგ შემთხვევაში დაიბეჭდება მხოლოდ ტექსტი. 

Black and White - შავ-თეთრი პრინტერისათვის მოხდება ფერების უგულვებელყოფა; Draft 

Quality - ჩაირთვება ეკონომიური ბეჭდვის რეჟიმი; Row and Column Heading - დაიბეჭდება 

ფურცლის სვეტებისა და სტრიქონების დასახელება; Comments - შეგვიძლია გამოვიტანოთ 

უჯრედის კომენტარი. 

Page Order ველში შეირჩევა მრავალგვერდა ცხრილის გვერდების დაბეჭვდის 

რიგითობა - Down, then over (ზევიდან ქვემოთ) ან Over, then down (მარცხნიდან მარჯვნივ). 

ზემოთ ჩამოთვლილი ზოგიერთი მოქმედება შეიძლება შესრულდეს Page Layout 

მენიუს Page Setup, Scale to Fit, Sheet Options და Arrange  ქვემენიუების შესაბამისი 

ბრძანებებით. 

დოკუმენტის დაბეჭდვა. დოკუმენტის დასაბეჭდად File მენიუში შევარჩიოთ Print 

⇒ Print ბრძანება ან Page Setup დიალოგურ ფანჯარაში დავაჭიროთ Print ღილაკს ან 

გამოვიყენოთ კლავიშთა კომბინაცია <Ctrl>+<P>. გაიხსნება Print დიალოგური ფანჯარა. 

დიალოგის All გადამრთველის ჩართვა გამოიწვევს მთელი დოკუმენტის დაბეჭდვას. 

Page(s) გადამრთველი გამოიყენება კონკრეტული გვერდების ან მათი დიაპაზონის 

დაბეჭვდისას. 

ამ შემთხვევაში From ველში მივუთითებთ საწყისი გვერდის ნომერს, ხოლო To 

ველში ბოლო გვერდის ნომერს. Selection - გადამრთველის ჩართვით დაიბეჭდება 

წინასწარ გამოყოფილი ფრაგმენტი, Active sheet(s) - დაიბეჭდება აქტიური ფურცელი, 

ხოლო Entire workbook - მთელი დავთარი. Number of copies ველში შეირჩევა დასაბეჭდი 

ასლების რაოდენობა. თუ პრინტერი მზადყოფნაშია, ბეჭდვა დაიწყება OK ღილაკზე 

დაჭერით. 

მონაცემთა რელაციური ბაზები. მონაცემთა რელაციური ბაზა არის ერთმანეთთან 

ლოგიკურად დაკავშირებული ცხრილების ერთობლიობა. მონაცემთა რელაციური ბაზის 

დაპროექტებისას უნდა დავიცვათ შემდეგი წესები: 

• მონაცემთა ბაზაში თითოეულ ცხრილს უნდა ჰქონდეს უნიკალური სახელი და 

უნდა შედგებოდეს ერთტიპური სტრიქონებისაგან. 

• ნებისმიერ ცხრილს ერთი სვეტი მაინც უნდა ჰქონდეს. 

• თითოეული ცხრილი შედგება სვეტებისა ფიქსირებული რაოდენობისაგან. 

სტრიქონის ერთ სვეტში მოთავსებული უნდა იყოს მხოლოდ ერთი 

მნიშვნელობა. მაგალითად, ნებისმიერი სტრიქონის სვეტი gvari უნდა შეიცავდეს 

მხოლოდ ერთ გვარს. 

• ცხრილის სტრიქონებს სახელები არ აქვთ, მათი რიგითობა განსაზღვრული და 

მათი რაოდენობა შეზღუდული არ არის.   

• ცხრილში სვეტები განლაგებულია იმ მიმდევრობით, რა მიმდევრობითაც იყო 

მითითებული მათი სახელები ცხრილის შექმნის დროს. 

• ცხრილში არ უნდა იყოს ზუსტად ერთნაირი ორი სტრიქონი. სტრიქონები უნდა 

განსხვავდებოდეს ერთი სვეტის მნიშვნელობით მაინც, რომ შესაძლებელი იყოს 

მათი ცალსახად იდენტიფიცირება. 
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• ცხრილის შიგნით თითოეულ სვეტს უნდა ჰქონდეს უნიკალური სახელი. თუმცა, 

სხვადასხვა ცხრილებს შეიძლება ერთნაირი სახელის მქონე სვეტები ჰქონდეთ. 

სვეტისთვის უნდა განისაზღვროს მასში მოთავსებული მონაცემების ტიპი. 

მაგალითად, რიცხვი, წილადი, ტექსტი, თარიღი და ა.შ. 

• მონაცემების დამუშავებისას შესაძლებელი უნდა იყოს თავისუფალი მიმართვა 

ნებისმიერ სტრიქონთან ან სვეტთან. 

პირველადი გასაღები. ნებისმიერ ცხრილს აქვს ერთი ან მეტი სვეტი, რომელიც 

ცალსახად განსაზღვრავს თითოეულ სტრიქონს. ასეთ სვეტს (ან სვეტებს) პირველადი 

გასაღები (PRIMARY KEY) ეწოდება. ის უნდა აკმაყოფილებდეს შემდეგ მოთხოვნებს: 

• უნიკალურობა. ეს იმას ნიშნავს, რომ ცხრილში არ უნდა იყოს ორი ისეთი 

სტრიქონი, რომლებსაც პირველადი გასაღების ერთნაირი მნიშვნელობები 

ექნებათ. 

• მინიმალურობა. ეს იმას ნიშნავს, რომ პირველად გასაღებში შემავალი 

სვეტებიდან ნებისმიერის გამოკლება უნდა იწვევდეს გასაღების უნიკალურობის 

დარღვევას. ანუ, პირველადი გასაღები არ უნდა შეიცავდეს ისეთ სვეტს, რომლის 

მოცილების შემდეგ გასაღები ისევ უნიკალური დარჩება. 

დინამიური ცხრილების (Pivot Table) საშუალებით ძალზე მოსახერხებელია 

მონაცემთა მრავალგანზომილებიანი მასივების დამუშავება. დინამიური ცხრილი 

ინტერაქტიული ცხრილია, რომელსაც მონაცემთა დიაპაზონისა და მონაცემთა ბაზის 

ველების ინფორმაციის ასახვისა და ანალიზის მოქნილი საშუალებები აქვს. დინამიური 

ცხრილების საშუალებით შესაძლებელია რიცხვითი მონაცემების შეკრება და 

გაერთიანება, საბოლოო შედეგების მიღება კატეგორიებისა და ქვეკატეგორიების 

მიხედვით, მონაცემთა ყველაზე საჭირო და საინტერესო ქვესიმრავლის ფილტრაცია, 

დალაგება, დაჯგუფება და პირობითი დაფორმატება. 

იმისათვის, რომ დაწვრილებით მოხდეს რიცხვითი მონაცემების გაანალიზება 

გამოიყენება PivotTable და PivotChart შეტყობინებები. ამისათვის, ჯერ უნდა მოხდეს 

დიაპაზონის ერთ-ერთი უჯრედის გააქტიურება და შემდეგ PivotTable და PivotChart 

შეტყობინებების შექმნა ხდება Insert მენიუს Tables ქვემენიუს PivotTable ან იგივე 

ქვემენიუს PivotTable→PivotTable ბრძანებით. გაიხსნება Create PivotTable დიალოგური 

ფანჯარა. რომლის Choose the data that you want to analyze ველში ჩავრთოთ Select a table or 

range გადამრთველი თუ მონაცემები მოთავსებულია მოცემულ სამუშაო ფურცელზე და 

Table/Range ველში მიეთითება ცხრილის უჯრედების ის დიაპაზონი, რომლის 

საფუძველზე ვაპირებთ დინამიკური ცხრილის შექმნას, ხოლო თუ გასაანალიზებელი 

მონაცემებისათვის გამოიყენება გარე წყაროები, მაშინ უნდა ჩავრთოთ Use an external data 

source გადამრთველი და მივუთითოთ ამ წყაროს მისამართი. 

Choose where you want the PivotTable report to be placed ველში ჩავრთოთ New 

Worksheet გადამრთველი, თუ გვინდა დინამიური ცხრილი განთავსდეს ახალ სამუშაო 

ფურცელზე, ხოლო იგივე ფურცელზე განთავსების მიზნით ჩავრთოთ Existing Worksheet 

გადამრთველი და Location ფანჯარაში მივუთითოთ ახალი ცხრილის ადგილმდებარეობა 

და მაუსი დავაწკაპუნოთ OK ღილაკზე ან ხელი დავაჭიროთ <Enter> კლავიშს, რის 

შემდეგაც შესაბამის ფურცელზე გამონათდება დინამიური ცხრილის მაკეტი და Pivot 

Table Field List დამატებითი ფანჯარა, სადაც განთავსებულია ცხრილის სვეტების 

სათაურები და სექციები მონიშნული ველების განსათავსებლად: Filters - ფილტრები, 
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Columns - ჰორიზონტალური დახარისხების ველები, Rows - ვერტიკალური 

დახარისხების ველები, ΣValues - გამოსაანგარიშებელი ველები, ხოლო განახლების 

რეჟიმის ჩასართველად ალმით მოვნიშნოთ ველი Defer Layout Update.  

მაუსით მოვნიშნოთ საჭირო ველები და მერე გადათრევით ისე გადავანაწილოთ 

ისინი სექციებს შორის, რომ გამოსაანგარიშებელი  ველები იყოს ΣValues სექციაში, ხოლო  

დახარისხების ველები - Rows ან/და Columns სექციებში. შედეგად მითითებულ ადგილზე 

შეიქმნება დინამიური ცხრილი. 

ამავე დროს ეკრანზე გამოჩნდება დამატებითი Pivot Table Tools/Analyze და Pivot 

Table Tools/Design მენიუები, რომლებიც შეიცავს დინამიურ ცხრილთან სამუშაო 

ინსტრუმენტებს. ამ ინსტრუმენტების პანელზე განლაგებული ბრძანებათა ღილაკების 

საშუალებით შესაძლებელია დინამიური ცხრილის ანალიზი და რედაქტირება. 
 

პრაქტიკული სამუშაოები: Microsoft Access-ში მარტივი ცხრილის შექმნა და მასში 

ინფორმაციის შეყვანა; Excel-ში დიდი ცხრილის მონაცემების სტატისტიკური ანალიზი 

დინამიური ცხრილების საშუალებით. 
 

 თემა 14. Excel-ის  Data მენიუს  ბრძანებები 

მონაცემთა დახარისხება. დახარისხება არის მონაცემთა ან სიის დალაგება 

განსაზღვრული თანმიმდევრობის მიხედვით. დახარისხება შეიძლება ზრდადობისა და 

კლებადობის მიხედვით. დიაპაზონის დახარისხების დროს სასურველია დიაპაზონში ან 

იყოს სვეტის დასახელება. დახარისხების დროს დამალული სტრიქონები სასურველია 

გამოვაჩინოთ. 

მონაცემთა დახარისხება შეიძლება მოვახდინოთ ტექსტის (A-დან Z-მდე ან 

პირიქით), რიცხვების (უმცირესიდან უდიდესისაკენ ან უდიდესიდან უმცირესისაკენ) და 

აგრეთვე დროისა და თარიღის (ძველიდან ახლისაკენ ან პირიქით) მიხედვით. 

მონაცემთა დასახარისხებლად მონიშნეთ დასახარისხებელი სვეტის რომელიმე 

უჯრედი, ზრდადობის მიხედვით დასახარისხებლად დავაჭიროთ Data მენიუს ღილაკზე 

Sort Smallest to Largest,  კლებადობის მიხედვით დასახარისხებლად დავაჭიროთ Data 

მენიუს ღილაკზე Sort Largest to Smallest. 

მონაცემთა დახარისხება რამოდენიმე სვეტის მიხედვით. მონიშნეთ მონაცემთა 

დიაპაზონის რომელიმე უჯრედი. Data მენიუს Sort & Filter (დახარისხება და ფილტრი) 

ჩანართში დააჭირეთ Sort (დახარისხება) ღილაკზე. გამოსულ დიალოგურ ფანჯარაში 

დააჭირეთ Sort by ველში ისარზე და შემდეგ იმ სვეტის სათაურზე, რომელშიც ახდენთ 

მონაცემების დახარისხებას. დააჭირეთ ჯერ Sort on ველში ისარზე და აირჩიეთ 

მონაცემების დახარისხების პრინციპი, შემდეგ Order (რიგი) ველში, ისარზე. აირჩიეთ 

დახარისხების ერთ-ერთი ელემენტი A to Z (ზრდადობის მიხედვით) ან  Z to A 

(კლებადობის მიხედვით). 

დახარისხების დონის დამატება. მონიშნეთ მონაცემთა დიაპაზონის რომელიმე 

უჯრედი. Data მენიუს Sort & Filter ჩანართში დააჭირეთ Sort  ღილაკზე შემდეგ Add Level 

(დონის დამატება) ღილაკზე და განსაზღვრეთ დახარისხების პარამეტრები. 

დახარისხების დონის წაშლა. მონიშნეთ მონაცემთა დიაპაზონის რომელიმე 

უჯრედი. Data მენიუს Sort & Filter (დახარისხება და ფილტრი) ჩანართში დააჭირეთ Sort  

ღილაკზე. მონიშნეთ დახარისხების დონე, რომელიც უნდა წაშალოთ. დააჭირეთ Delete 

Level (დონის წაშლა) ღილაკზე. 
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მონაცემთა ფილტრაცია. მონაცემთა ბაზის ფილტრაციის ბრძანებები საშუალებას 

იძლევა, ფურცელში ავსახოთ მხოლოდ ის მონაცემები, რომლებიც აკმაყოფილებენ 

გაფილტვრის დროს მითითებულ პირობებს. 

ავტომატური ფილტრის გამოყენება სამუშაო ფურცელზე. გააქტიურეთ მონაცემთა 

დიაპაზონის ერთ-ერთი უჯრედი. მონაცემთა ავტომატური ფილტრაცია ხდება Data 

მენიუს Sort & Filter ქვემენიუს Filter ბრძანებით ან <Ctrl>+<Shift>+<L> კლავიშთა 

კომბინაციით, რომელიც საშუალებას გვაძლევს გამოვიყენოთ გაფილტვრის მარტივი 

კრიტერიუმები. 

ავტომატური გაფილტვრის დროს ყოველი სვეტის სათაურის უჯრედში 

გამოჩნდება ავტოფილტრის ისარი. დავაჭიროთ იმ სვეტის ისარს, რომლის შემცველობის 

მიხედვით ვაპირებთ ცხრილის ფილტრაციას. გაიხსნება სვეტის უნიკალურ მონაცემთა 

ჩამონათვალი. თუ რომელიმე მონაცემი სვეტში მეორდება, ის ერთხელ იქნება ნაჩვენები. 

ჩამონათვალში მონიშვნა დავუტოვოთ მხოლოდ იმ მონაცემებს, რომლის 

მიხედვითაც წარმოებს ფილტრაცია. თუ ფილტრაციას ვატარებთ რამოდენიმე სვეტის 

შემცველობის მიხედვით, იგივეს გავიმეორებთ სხვა სვეტებისათვისაც. დააჭირეთ OK 

ღილაკზე. განხორციელდება ცხრილის ავტომატური ფილტრაცია და გამონათდება 

მხოლოდ ის სტრიქონები, რომლებიც სვეტებში შეიცავს ფილტრაციის შერჩეული 

კრიტერიუმის შესაბამის მონაცემებს. 

ავტოფილტრის ისარზე დაჭერით გამონათებულ ჩამონათვალში Select All 

ბრძანების არჩევით და OK ღილაკზე მაუსის დაწკაპუნებით გამონათდება ცხრილი 

საწყისი სახით. 

რიცხვითი ინფორმაციის შემცველ სვეტს ავტოფილტრის მენიუში აქვს ბრძანება 

Number Filters (რიცხვითი ფილტრები), რომლის ჩამონათვალში შეირჩევა ფილტრაციის 

პირობა: ტოლია (Equals ...), არ უდრის (Does Not Equal ...), მეტია (Greater Than ...), მეტია ან 

ტოლი (Greater Than Or Equal To ...), ნაკლებია (Less Than ...), ნაკლებია ან ტოლი (Less Than 

Or Equal To ...), მოთავსებულია რიცხვებს შორის (Between ...), საშუალო რიცხვზე მეტია 

(Above Average) და საშუალო რიცხვზე ნაკლებია (Below Average). 

მაგალითად, ავტოფილტრის ისარზე დაჭერით მიღებულ ჩამონათვალში Number 

Filters→Top 10 ... ბრძანების არჩევით გამონათდება მხოლოდ ამ სვეტის ათი მაქსიმალური 

მონაცემის შემცველი სტრიქონი. 

ტექსტური ინფორმაციის შემცველ სვეტს ავტოფილტრის მენიუში აქვს ბრძანება 

Text Filters (ტექსტური ფილტრები), რომლის ჩამონათვალში შეირჩევა ფილტრაციის 

პირობა: ტოლია (Equals ...), არ უდრის (Does Not Equals ...), იწყება სიმბოლოთი (Begins With 

...), მთავრდება სიმბოლოთი (Ends With ...), შეიცავს სიმბოლოს (Contains ...) და არ შეიცავს 

სიმბოლოს (Does Not Contain ...). 

ფილტრის გაუქმება. გააქტიურეთ მონაცემთა დიაპაზონის ერთ-ერთი უჯრედი. 

Data მენიუს Sort & Filter ჩანართში დააჭირეთ Filter ღილაკზე ან ღილაკზე Clear 

(გასუფთავება). 

გაფართოებული ფილტრი (Custom Filter). ავტომატურისაგან განსხვავებით, 

გაფართოებული ფილტრი (Custom Filter) გაფილტვრის ლოგიკურად უფრო რთული 

კრიტერიუმების გამოყენების საშუალებას გვაძლევს. 

Data Tools ქვემენიუს ბრძანებები. 
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Text to Columns -  ერთ უჯრედში მოთავსებულ ტექსტს დაყოფს და განათავსებს 

ცალკე უჯრედებში. 

Flash Fill - ლოგიკიდან გამომდინარე ავტომატური შევსების რეჟიმი; 

Remove Duplicates - დაყოფილ ტექსტს ცალკეულ უჯრედებში გააერთიანებს. 

Data Validation - შესაძლებლობას იძლევა გარკვეული კრიტერიუმით დავიცვათ 

კონკრეტული უჯრედები მონაცემთა შეტანისაგან, გამოვავლინოთ დაუშვებელი 

სიდიდეები, მოვახდინოთ გაფრთხილება. 

Consolidate - ხდება სხვადასხვა ადგილას (არეში) ჩაწერილი სიდიდეების 

განთავსება სხვა ახალ ადგილას. საწყის მონაცემთა (ანგარიშში შემავალ) სხვადასხვა 

მნიშვნელობებისათვის ხდება საშედეგო სიდიდის გამოკვლევა (თუ როგორ იცვლება). 

აპარატი: Goal Seek, Scenario, Data Table. 

Outline ქვემენიუს ბრძანებები. 

Group - უჯრედითა გარკვეული რაოდენობის დაჯგუფება, დაჯგუფების მოხსნის 

შესაძლებლობით. 

Ungroup - დაჯგუფების მოხსნა. 

Subtotal - გარკვეული კატეგორიების მიხედვით ქვეჯამების გამოტანა. 

 

პრაქტიკული სამუშაოები: Excel-ში დიდი ცხრილის მონაცემების გაფილტვრა,  

დახარისხება, დაჯგუფება და დაჯამება Data მენიუს ბრძანებების საშუალებით; Text to 

Columns, Flash Fill, Remove Duplicates, Data Validation, Consolidate ბრძანებების გამოყენება. 
 

თემა 15. Access-ში მონაცემების შეყვანა და იმპორტირება Excel-ში 

მონაცემების იმპორტი 

ინფორმაციის იმპორტირების მთავარი სარგებლობა მდგომარეობს იმაში, რომ 

ჩვენ პერიოდულად შეგვიძლია MS Excel-ში არაერთხელ გავაანალიზოთ ეს მონაცემები 

მათი კოპირების გარეშე, რომელმაც შეიძლება წაგვართვას დიდი დრო და გამოიწვიოს 

შეცდომები. გარე მონაცემებთან დაკავშირების შემდეგ შეგვიძლია ავტომატურად 

განვაახლოთ ჩვენი სამუშაო დავთარი მონაცემთა დედანიდან. აგრეთვე უნდა 

გავითვალისწინოთ, რომ მონაცემთა ბაზის მართვის სისტემებში ინფორმაციის შეყვანის 

პროცესი მაქსიმალურად გაადვილებული და დაცული არის, ამიტომ შეყვანილი 

ინფორმაცია შეიცავს ნაკლებ შეცდომას. 

მონაცემთა ბაზების მართვის სისტემა Microsoft Access. მონაცემთა ბაზების 

ფორმირებისთვის იყენებენ Microsoft Office-ის პროგრამას Access.  Microsoft Access 

საშუალებას იძლევა ვიმუშაოთ როგორც მარტივ, ისე რთულ მონაცემთა ბაზებთან. ეს 

პროგრამა, ინფორმაციის სხვადასხვა კატეგორიებს შორის ურთიერთობებს 

განსაზღვრავს, რაც მრავალი სახის მონაცემის ერთდროულად გამოყენების საშუალებას 

გვაძლევს. მონაცემთა ბაზის ფუძეს შეადგენს მასში შენახული ინფორმაცია, მათთან 

მუშაობისათვის Microsoft Access აქვს მნიშვნელოვანი კომპონენტები, რომელთაც 

ობიექტები ეწოდება. 

Microsoft Access-ში შექმნილი მონაცემთა ბაზა შეინახება ფაილის სახით .accdb 

გაფართოებით. მონაცემთა ბაზა რამდენიმე ობიექტისაგან შედგება, ესენია: ცხრილები, 

მოთხოვნები, ფორმები, ანგარიშები, გვერდები, აგრეთვე მაკროსები და მოდულები. 

მოკლედ დავახასიათოთ თითოეული მათგანი: 
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ცხრილი (Table) ობიექტია, რომელიც იქმნება მონაცემების შესანახად მყარ 

დისკზე. ყოველი ცხრილი შეიცავს საგნის ან სუბიექტის შესახებ გარკვეულ ინფორმაციას 

(მაგალითად, სავაჭრო დაწესებულებაში საქონლის ან კლიენტის მონაცემებს). ცხრილის 

ველები (სვეტები) ინახავენ საგნის (სუბიექტის) სხვადასხვა მახასიათებლებს 

(მაგალითად, კლიენტის გვარს, მისამართს), ხოლო ჩანაწერები (სტრიქონები) შეიცავენ 

კონკრეტული სუბიექტის შესახებ სრულ ცნობას. ყოველი ცხრილისთვის შესაძლებელია 

განვსაზღვროთ პირველადი გასაღები - ველი (ერთი ან რამდენიმე ველი), რომელშიც 

თავსდება უნიკალური მნიშვნელობა - იდენტიფიკატორი (კოდი) და გარე გასაღები-

ველი, რომლითაც იგი დაუკავშირდება სათავო ცხრილს. 

მოთხოვნა (Query) არის ობიექტი, რომელიც მომხმარებელს საშუალებას აძლევს 

მიიღოს საჭირო ცნობები ერთი ან რამდენიმე ცხრილიდან მის მიერვე ჩამოყალიბებული 

სტრუქტურით. 

ფორმა (Form) ობიექტია, რომლის დანიშნულებაა მონაცემების გამარტივებული 

წესით შეტანის უზრუნველყოფა (არა პირდაპირ ცხრილებში). ფორმა აგრეთვე 

მონაცემების ეკრანზე თვალსაჩინოდ წარმოდგენის, დათვალიერების და მონაცემთა 

ბაზის ზოგიერთი ოპერაციის მართვის საშუალებაა. 

ანგარიში (Report) არის ობიექტი, განკუთვნილი შერჩეული შედეგების 

დაფორმატების, გამოთვლების ჩატარების და საბეჭდ მოწყობილობაზე გატანისათვის. 

ბეჭდვის წინ შესაძლებელია მისი წინასწარი გადახედვა ეკრანზე. ანგარიშებში 

გათვალისწინებულია სპეციალური საშუალებები მონაცემების დასაჯგუფებლად, 

გაფორმების სპეციალური ელემენტების გამოსატანად (ზედა და ქვედა 

კოლონტიტულები, გვერდის ნომერი, დამხმარე ინფორმაცია ანგარიშის შექმნის 

თარიღის შესახებ და სხვ.).  

მაკროსი (Macro) - მაკროსი წარმოადგენს ერთი ან რამდენიმე მოქმედების 

სტრუქტურირებულ აღწერას და ავტომატურად სრულდება რომელიმე ხდომილების 

საპასუხოდ. 

მოდული (Module) - მოდული შეიცავს Visual Basic ენაზე დაწერილ პროგრამას.  

მონაცემთა იმპორტი შეიძლება განხორციელდეს Data მენიუს Get External Data 

ქვემენიუს ბრძანებებით. პირველი ამ ბრძანებებს შორის არის ბრძანება From Access, 

რომლის საშუალებითაც ხდება მონაცემთა იმპორტი MS Access-დან. ეს ბრძანება 

გამოიძახებს დიალოგურ ფანჯარას Select Source File, სადაც უნდა მივუთითოთ 

მონაცემთა ბაზის ფაილი, საიდანაც მოხდება მონაცემების კოპირება. დავაჭიროთ ღილაკს 

Open -  გაიხსნება ფანჯარა Select Table, სადაც უნდა მოვნიშნოთ ის ცხრილი, რომელიც 

შეიცავს სასურველ ინფორმაციას. დავაჭიროთ ღილაკს OK - გაიხსნება ფანჯარა Import 

Data, სადაც უნდა ავირჩიოთ მონაცემების წარმოდგენის ვარიანტი - Table, PivotTable 

Report, PivotChart, Only Create Connection. დავაჭიროთ ღილაკს OK - მონაცემები ჩაისმევა 

Excel-ის სამუშაო ფურცელში მონიშნული უჯრედიდან დაწყებული. 

არსებობს Excel-სა და Access-ს შორის მონაცემების მიმოცვლის რამოდენიმე ხერხი. 

მონაცემების გადმოსატანად შეიძლება გამოვიყენოთ Access-ის სპეციფიკაციის მქონე 

მონაცემების კოპირება და ჩავსვათ იგი Excel-ის სამუშაო ფურცელში, ან მოვახდინოთ 

Access-ის მონაცემების ექსპორტი Excel-ის სამუშაო ფურცელში. 

მონაცემების გადასატანად Excel-იდან Access-ში შეიძლება ვისარგებლოთ Excel-ის 

სამუშაო ფურცელიდან მონაცემების კოპირებით და ჩავსვათ იგი Access-ის 
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სპეციფიკაციაში, ან მოვახდინოთ Excel-ის სამუშაო ფურცლის ექსპორტი Access-ში ან 

Excel-ის სამუშაო ფურცელს დავუკავშირდეთ Access-ის ცხრილიდან. აგრეთვე შეგვიძლია 

გამოვიყენოთ ფორმატები csv (Comma delimited) და text (Tab delimited). ამ ფორმატებში 

შენახული Excel-ის ცხრილების იმპორტი Access-ის ცხრილში სრულდება ცხრილის 

კონტექსტური მენიუდან ბრძანებით Import→Text File. 

Excel-სა და Access-ს შორის მონაცემების იმპორტს აქვს ორი სხვადასხვა 

მნიშვნელობა. სიტყვა იმპორტი Excel-ში ნიშნავს, რომ განახლებად მონაცემებთან იყოს 

მუდმივი კავშირი, ხოლო Access-ში სიტყვა იმპორტი ნიშნავს მონაცემების ერთხელ 

გადატანას, მონაცემთა კავშირის გარეშე. Excel-ის მონაცემებიდან შეუძლებელია შეიქმნას 

Access-ის მონაცემთა ბაზა. 

 

პრაქტიკული სამუშაოები: Access-ში მარტივი მონაცემთა ბაზის შექმნა, მასში 

მონაცემთა შეყვანა და ამ მონაცემების  იმპორტი Excel-ში. 
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